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2 Release Notes
Here, you can find the Release Notes for the individual Service Packs and Fix Packs of the Infront 
Professional Terminal.

Release Notes 8.6.700
Release Notes 8.6.600
Release Notes 8.6.500
Release Notes 8.6.400

2.1 Release Notes 8.6.700

See also:

ESG risk scores in Bond and Fund Overview
Spreads in curve chart
Dynamic focus line in chart
Debt Maturity profile 2.0
CDS search navigation from Company overview
Bond Lookup from credit ratings

2.1.1 ESG risk scores in Bond and Fund Overview

Our ESG dataset is now further integrated into the "Fund Overview" and "Bond Overview".

ESG tab in Bond Overview
For corporate bonds, the risk scores of the respective issuer is applied to the bond similar as to how the 
issuer scores are applied to equities on the familiar 3 level granularity:

Release Notes for older program versions can be found in the Archive.
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Government specific risk scores and parameters for the issuing state are applied for treasury notes and 
bills. In contrast to the company scores, these measure the business environment of the nation, political 
stability, technological innovation, taxation policies, corruption and so on.
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ESG tab in Fund Overview
Fund specific scores are presented in the new "ESG" tab of the "Fund Overview" and reflect the specific 
funds risks based on the fund holdings and diversification.

For example, Blackrock's different funds will have different scores based on their exposure and 
diversification:

These can be easily compared in a watchlist or with asset specific columns:
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2.1.2 Spreads in curve chart

The curve chart now offers the ability to chart spreads directly. This allows for spread studies on the yield 
curves and visual comparison across several curves.

In the top right corner, the constituents of the spread may be selected based on the existing curve chart. 
The chart below shows the German (TMBMKDE) vs. the US (TMUBMUSD) yield curve in blue and orange, 
respectively. The yellow line graphs the spread between the two. Additional curves may be added for further 
spread charting.

Historical spreads can always be charted directly by selecting two instruments, right-clicking and selecting 
spread:
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Historical spread charting:
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2.1.3 Dynamic focus line in chart

For instruments with low liquidity, bid/ask prices provide the next best thing in absence of actual trades 
data. These instances are now detected and the chart dynamically selects the best chart parameter fit for 
purpose given the instruments liquidity and price availability.

Below, you see a typical illiquid warrant with few trades and hence last prices. The chart automatically 
detects this and actively selects Bid rather than Last prices, thus providing a better visualisation of the 
pricing development given the liquidity and availability of price points.

When the feature is enabled, this is clearly shown in the toolbar and may be switched off at your preference:
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The same logic applies to fixed income securities where yield is favoured if sufficient pricing is available.

Illustrated with Schneider bond maturing in 2029 where price development in yield is now automatically 
presented.

This may of course be switched off in single instances or permanently.

The new functionality can be viewed as a "Focus Line" in the toolbar of the charts and will appear with a 
message to inform you about the selection done on your behalf, and why, given the liquidity and price 
availability of the selected instrument.

This functionality can be adjusted or disabled completely to your preference in advanced settings:
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2.1.4 Debt Maturity profile 2.0

The "Debt Maturity" profile now detects the number of outstanding bonds from the issuer and dynamically 
optimises the presentation of the bar chart. Thus, a bank with several hundred mortgage bonds will be 
summarised to single columns on an annual basis for a view that is easier to read.

Every single bond can be viewed as its constituent within the bar and individually viewed for further details:
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A more typical corporate structure with 13 Issues will automatically be selected and displayed on a monthly 
basis:
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The number of issues, total sum outstanding and weighted coupon is summarised for this issuer:
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2.1.5 CDS search navigation from Company overview

Credit Default Swaps from Tullet Prebon Information can now be found under linked symbols in the 
"Company Overview". This makes navigation easier and displays availability of CDS data directly within the 
"Company Overview":
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Clicking the CDS will populate a watchlist with the respective CDS series. From here, a curve chart can be 
opened by marking all instruments and opening "Curve Chart" for preferred selection.
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2.1.6 Bond Lookup from credit ratings

The new "Bond Lookup" function allows you to move directly from a selected credit rating to the underlying 
rated issuer's bonds. This link enables the connection between issuer and their respective issues and can 
be reached from "Credit Ratings" regardless if it is found in a market overview, watchlist or "The Credit 
Ratings Issuer" feeds, (Moody's, Fitch or S&P).
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2.2 Release Notes 8.6.600

See also:

ESG data launched in Infront Professional Terminal
ESG features, methodology and use cases
ATR-based day-trading signals

2.2.1 ESG data launched in Infront Professional Terminal
We are pleased to introduce a comprehensive ESG dataset in the latest version of our Professional Terminal 
- 8.6.600.
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Adding to the Infront Professional Terminal's extensive data universe, ESG data and framework is 
seamlessly integrated through new and familiar functionality to effortlessly incorporate ESG in your daily 
workflow.

The dataset is powered by Clarity AI and covers equities, bonds and funds on three levels, allowing a 
detailed analysis down to specific metrics. The insight from this data is carried forward by a completely 
new ESG platform in addition to new columns and fields to be integrated in existing layouts and desktops.

2.2.2 ESG features, methodology and use cases
A new ESG Platform to visualise and contextualise three levels of data on a company level, easily 
accessed from the right-click menu of a company (or you can double-click any ESG column):

Scores are colour-coded based on performance in addition to visual elements for their respective 
category within Environmental, Social or Governance:
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The ESG dataset is based on scores ranging from 0-100 (with 100 as the best) and covers companies, 
funds and governments. The scores express the risk and opportunities the company holds against key 
exposure points within the respective specific sector.

ESG Risk scores aim to assess the financial materiality of environmental, social and governance issues 
related to how companies and governments operate. Hence, scores assess how ESG issues potentially 
affect future financial performance.

Companies in the same industry generally face the same major risks and opportunities, though individual 
exposure can vary.

ESG Risk scores allow investors to assess how well the companies and countries in a given portfolio are 
managing their Environmental, Social and Governance related risks and opportunities.

A risk is material to an industry when it is likely that companies in a given industry will incur substantial 
costs in connection with it (for example, a regulatory ban on a key chemical input requiring reformulation).

Furthermore, a new regulation coming into place can correspondingly shift the scores of an entire sector 
and in turn develop depending on how the companies individually address this regulation.
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As such, the risk score can be interpreted as to what extent the company has mitigated risk or holds 
exposure towards ESG factors faced in the respective sector. Both the exposure and the potential impact 
on financial materiality is weighted into a risk score.

As an example, this is why Repsol as an oil and energy company can hold a higher environmental score at 
87 than Vestas Wind at 59. This tells us that Repsol have mitigated their exposure to a larger extent or 
holds a more robust and diversified business model, better positioned for the opportunities within the oil 
and energy sector, which again may lead to strong future financial performance.

Detailed documentation on methodology and framework is available through our sales, support and client 
success team.

The platform includes an "Industries" tab for deeper insight within a sector as well as configurable 
peer group analysis and graphics. The calculation method can be adjusted to your preference and 
the platform can also be linked to other windows:
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A new column set is introduced to be applied in market overview and watchlists to bring forward this 
advanced dataset. Applying the terminal's column sorting and filtering, this enables you to easily 
screen and structure an entire market based on overall ESG score. Detailed parameters such as 
Supplier Footprint or Corporate Ethics may be applied as well as seen in the example with the Xetra 
exchange below:

By applying the ESG Basic layout to the Xetra main market, you can filter out only the top ESG score 
candidates by sliding the bar in the column filter. For example, you will find that even though 
Fresenius falls within this range at the total score, Fresenius' "Environmental" score is quite poor at 
36 further explained by the third level parameters shown in the hover, clearly weakened by the 
"Emissions" score at only 25.

In addition to a new column category found in the configurator, two new ESG layouts were added to 
the factory layouts and can easily be applied to any market overview or watchlist.
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The "ESG Basic" layout includes 2 levels of granularity, and the "ESG Full" layout naturally includes all the 
parameters for a more detailed approach:

The dataset covers equities, fixed income and funds, so by applying the layout in a watchlist you may 
combine these for a cross-asset overview.
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Individual scores are available in the "Details" tab of every "Instrument Overview" window and 
included in the "Peer group" overview on the "Company Overview" tab.

For questions or additional information, please refer to your respective Client Success Manager or reach out 
to our support.

2.2.3 ATR-based day-trading signals
We have introduced four new columns related to the calculation of ATR-based day-trading signals.

Using the values of these columns (and the possibility to sort or filter to only see the interesting signals) 
can help you make decisions about when to buy or sell securities in the market.

ATR30 (Average True Range 30 days) is a column we already support. It gives a measure of how much 
volatility there is typically/statistically the last 30 days in terms of nominal price changes.

This is used as the basis of calculating how much volatility there is in today's trading (measured in number 
of ATRs). There are three such measurements:

Change between previous close and high (S/High)
Change between previous close and low (S/Low)
Change between previous close and the current last price (S/Last)

Each of these is a signal, but only those signals above a minimum strength are of interest. This is set to 1 
ATR by default, but it can be configured in the settings to a value between 0.75 and 2 ATRs.

That limit settings indicates how aggressive or conservative you want to be in interpreting the signals.
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The fourth column (S/#) is an aggregated count that will be 0, 1 or 2. It indicates how many of the three 
signals above currently have a value exceeding the ATR Signal limit.

It can be convenient to sort on or filter on this signal count column to see only the ones with 1 or 2, because 
these will be the "interesting" cases in your universe of instruments (a market list or watch list). Normally, 
only a signal count of 2 should be considered a confirmed trigger.

The count column will be red for a sell signal and green for a buy signal. The signal will be opposite of the 
recent (possibly exuberated) movement, the theory being that it will return to normal.

The different ATR signal columns will show a hint with additional detailed information. This can be useful to 
optimise space by reducing the number of columns shown, while still being able to quickly look at the 
details behind any of the scores:

Notice that in some cases there can be two opposite scores, giving a score count of 2, but tagged as 
neutral.

To drill down further and see how the broken ATR levels show themselves in an intraday chart, it is possible 
to add various horizontal lines.
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The chart above shows that intraday trading first broke the PrevClose+ATR limit (blue line), then it broke 
down falling below the High-ATR level (red line) - giving in total a neutral signal now. Earlier in the day, it 
would probably have given a sell signal.

Always consider other factors, such as fundamental news, and other technical indicators before making a 
trading decision.

2.3 Release Notes 8.6.500

See also:

Credit ratings and WM data in the Infront Professional Terminal
Summary of new features and views
Ratings Schema and Links
WM Data

2.3.1 Credit ratings and WM data in the Infront Professional 
Terminal

As the next step in our integration plan and fixed income strategy, we introduced credit ratings and WM 
data in the latest version of Infront Professional Terminal.
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Following the integration of contributor bond data, credit ratings provide an added layer of insight into the 
debt market and its inherent credit risk. Ratings data is provided by the market leading agencies S&P, 
Moody's and Fitch* and includes ratings on the individual bonds on the issue level as well as the issuer on 
the overall entity level.

Several new features were introduced to help you navigate and structure this data:

First and foremost, a new set of columns which can easily be added to a "Market view" or your 
personal watchlist.

Columns can be added by using the "+" icon on the right of the columns. Or you can view the full selection 
in the "Select Columns" dialog window by the "Credit Ratings" category:
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As the agencies apply different scales to their rating methodology, each agency holds their own dedicated 
set of columns and fields. This means that there is no consolidated rating view across sources.

Consequently, individual agency feeds are also available in the "Market" view:

In the individual agency feeds, the respective columns are automatically populated as seen below with S&P:

Every column offers filtering capabilities, allowing you to screen on a market or agency universe. 
Typical filtering scenarios include: only investment grade ratings, only the most recent assessments 
by date or only affirmations. For example, you can filter the Frankfurt Floor market based on Fitch 
rating, only "B" and above, by simply sliding the bar to the preferred level:



Infront Professional Terminal – Release Notes

04/25/2022 39 / 258

•

•

•

•

In the "Market" and "Watchlist" view, this can be applied across the agencies to show multiple rating 
agencies' columns (that is, S&P and Moody's). Moreover, the column filtering tool displays the 
distribution in a certain market or from the agency universe.
Feeds are available from each agency so you can typically filter out S&P's most recent upgrades by 
date, with a stable outlook and a current rating of A+ and above if you have a conservative mandate.
You can also filter yield intervals to capture any relationship between high yields and respective 
rating which traditionally should not fall within investment grade.
In the watchlist, you have full flexibility to further analyse different bonds across issuers and discover 
if certain properties of the loan affect the rating across the issuers' bonds.

A new tab was added to the "Bond Overview", consolidating the information for the specific bond. Long-
term ratings are displayed on the "Overview" tab:
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The "Custom Overview" consolidates all ratings data for the instrument and substitutes the "Instrument 
Overview".

2.3.2 Summary of new features and views
New column set for ratings with filtering capability
"Bond Overview" with new "Rating" tab
"Bond Overview" with long term rating fields in the "Overview" tab
A new ratings window replacing the "Instrument Overview" for a consolidated view of all ratings 
values

2.3.3 Ratings Schema and Links
For reference, please see the following resources available directly from the credit rating agencies. S&P and 
Fitch share the same scale while Moody's operate with their own scoring with Aaa to C:
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S&P: https://www.spglobal.com/ratings/en/about/intro-to-credit-ratings

Fitch: https://www.fitchratings.com/products/rating-definitions#about-rating-definitions
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Moody's: https://ratings.moodys.io/ratings#rating-scale

2.3.4 WM Data
"Bond reference data" from WM include new columns data and provides reference and price data points on 
duration, yields, convexity and many more as well as loan terms such as callable properties of the loan and 
at what time these can be called at the issuer's discretion. 

 

For a complete overview on the individual bond level, the fields populate at the bottom of the "Details" tab in 
instrument overview under "Bonds Info":

 

As with the "Ratings", this data can be applied as columns, allowing you to screen or sort a market and 
combine your own selections in a watchlist for further comparison and analysis.

WKNs are also supported as a new column which is searchable across terminal windows and functions, 
allowing you to quickly identify instruments based on WKN:
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For questions or additional information, please contact your respective Client Success Manager 
or reach out to our support.

2.4 Release Notes 8.6.400

See also:

Date specific historical lookback and compare in curve chart.
Debt maturity profile
Drag and drop symbol to watchlist
Volatility smile
Chart performance for custom period
FX Forwards and calculator view update

2.4.1 Date specific historical lookback and compare in curve chart.
Discover how forward, swap or yields curves reacted to historical events such as ECB announcements, 
inflation news and market incidents on specific dates. The date-specific lookback allows you to uncover 
movements and shifts in the curve for a particular day in question and enables you to pinpoint your 
preferred point in time.

In this example, we see the German yield curve and how it reacted to the ECB announcement January 21, 
2021 in green with a slight shift compared to the current view from the Last curve in blue.
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You can apply the date-specific compare function by selecting the "Date" checkbox in the bottom right 
corner in any curve chart to discover shifts in IR swap curves, FX Forward curves, CDS curves and so on.

Interest rate swap curve in euro on March 12, 2020, when WHO declared COVID-19 a global pandemic 
compared to the current Last value (in this case February 21, 2021).
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2.4.2 Debt maturity profile
Visual breakdown of a company's issued debt, when it is maturing and respective notional outstanding 
amount. You can hover each bar to view coupon and additional data.

If bonds are issued in different currencies, the chart automatically converts the currency to your selected 
conversion currency to compare them to scale in one axis.

From "Bond Screener" or any search, open the bond overview. On the "More from Issuer" tab, you can see if 
there are other bonds from the same issuing entity of the corporate, government or municipality. The "Debt 
Profile" tab will chart these and you can easily view the distribution of debt with respective maturity 
uncovering when the outstanding principal is maturing requiring the issuer to either pay back, refinance or 
restructure the loan. You may further analyse their cash flow and earnings ability to do so in the Company 
Analytics.
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2.4.3 Drag and drop symbol to watchlist
The green symbol info indicates that you can drag and drop it into a watchlist, allowing you to build lists 
based on already identified Instrument Overviews, Company windows and so on.

2.4.4 Volatility smile
The volatility smile charts the volatility of an option across strike prices. It visually represents how options 
with the same underlying and expiry date are valued base on implied volatility across strike prices.

Open an option market, right-click and select "Volatility Smile" under charts and a series of 6 steps below 
and above of strike prices are selected and is charted to easily see if the typical U shape for your selected 
strike range and its moneyness (ITM, ATM or OTM) applies or if market perception differs from the 
traditional pattern.
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2.4.5 Chart performance for custom period
You can quickly zoom in on a particular time period within a chart and the percentage performance on your 
left axis will adjust, automatically recalculating the return for that period.

For example, to take a closer look at the extreme movements for Roche as of COVID-19 hit and the lowest 
point at March 12, 2020 to the recovery back to the top at May 2020.

After zooming in on this specific period of your choosing, the percentage performance is re-adjusted on the 
left axis and we can quickly see the periods return on 31.71%.
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2.4.6 FX Forwards and calculator view update
Currency pair is split into two parts "Base" - "Quote" and shows a flag per currency.
Spot prices are displayed with enhanced decimals in "FX Forward Calculator", "FX Forwards" window 
and "Instrument Overview".
Swaps and outrights are displayed with a fixed decimal percision = 6.
Clarification on Swap and Outright components.
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1.
2.
3.
4.

3 Getting started
Get an overview of the Infront Professional Terminal user interface and learn about the various possibilities 
that the terminal offers.

See also:

Login
My Profile
Main menu
Search
Desktop
Workspace
Keyboard shortcuts

3.1 Login
To log into Infront Professional Terminal, you need credentials (username + password). This information is 
sent to you, either by your broker or by Infront, depending on which terminal you have.

3.1.1 How to log in to the Infront Professional Terminal
Download Infront Professional Terminal from our website.
Once the terminal opens, a login window will appear.
Type in your login credentials and click the "Log in" button.
To avoid entering login credentials every time you log in, select the "Remember me" checkbox.
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3.1.2 How to change password
To change your password, go to "Advanced settings" > select "Account Setup" > select "Login" > click the 
"Change Password" button.
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If you don't remember your password, you can click "Forgot password?", which you can find in the login 
window. Next, a new browser will appear where you can type in your username or e-mail. Once you have 
entered the necessary information, you will receive an e-mail, which contains instructions explaining how to 
generate a new password.
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3.2 My Profile
"My Profile" provides an overview of your user account and services you currently subscribe to. You can 
view and update your information on the "Account" page.

Click the "⋮" icon in the upper right corner of Infront Professional Terminal and then select "My Profile".
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Alternatively, type the command "My Profile" in the search field and press <ENTER>.

3.2.1 Add a free trial in My Profile
Some users can test features and various market data services. Order a trial by clicking the "Free Trial" 
button on the "New Services" page.

3.2.2 Order additional services
Some users can also order additional services. The payment method varies. If VISA and Mastercard icons 
are displayed, then this indicate that you have access to payment by credit card.
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Example of My Profile

3.2.3 My profile and credit card payment

3.2.4 Subscription agreements
On the "Account" page, you will find your account details and a list of the Contracts (EULAs) for the separate 
services you subscribe to.

3.2.5 My profile and credit card payment

Pay by credit card for additional services
The Visa and Mastercard icons indicate that you have access to payment by credit card. Select the services 
you want to add and click the "Checkout" button.
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In the next step, you accept the credit card agreement which states that monthly recurring charges will be 
made to your credit card once you start the subscription, that you can cancel the subscription at any time 
and that no refunds are made once the recurring payment for that month was processed.

The next step informs you of all recurring monthly costs.

After you have entered your credit card details on the PayEx page, you will be taken back to "My Profile", 
where you are informed that you may need to restart Infront Professional Terminal.

3.3 Main menu
The main menu is found on the toolbar and allows you to easily access all the ready-made asset class 
windows and tools in Infront Professional Terminal. The items in the menu depend on the features you have 
access to. If a link appears dimmed, this means that you do not have access to the content displayed in the 
main menu.

3.3.1 The Explore tab
On the "Explore" tab, we have created direct links to a range of content overviews to make the most 
important information available at your fingertips.

You can, at any time, cancel subscriptions on the "Subscriptions" page in "My Profile". The access 
expires at the end of the period paid for.
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3.3.2 The Tools tab
On the "Tools" tab, you can find the different tools available in Infront Professional Terminal. For example, 
market windows, news, calendar, watchlists or login to your trading account.
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You can hover your mouse pointer over a menu item to see the corresponding keyboard shortcut, if 
available.

3.4 Search

3.4.1 Easy search
You can search for instruments (<CTRL>+<F>) by typing in any of the following details of an asset:

Ticker code
ISIN
Company name
Descriptive name

The powerful search functionality ranks the search to display the most relevant results.

When selecting an instrument from the search results, a submenu will show up, giving you more options 
about what you would like to open.
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3.4.2 Commands
You can also execute commands from the search field.

Example

Type "histchart" and press <ENTER>. Start typing to find the instrument for which you want display the 
historical chart. There are many more commands you can use.



Infront Professional Terminal – Getting started

04/25/2022 62 / 258

3.4.3 Search in specific windows
Search directly in a chart, watchlist, orderbook or market window. Just start typing to perform the search on 
the list of symbols in an automatically prompted search window.

For example, you can search in a "Market" window.

Or you can search directly in a chart.

Learning the keyboard shortcuts for your favorite commands will let you find information even 
faster. For more information, see Keyboard shortcuts.
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3.5 Desktop
A workspace is collection of desktops, while a desktop is a collection of windows. Desktops can be 
compared to worksheets in Microsoft Excel and are only visible one at a time.

You can create your own desktops or choose from ready-made ones.

3.5.1 Open a desktop
Search for "desktop" in the search field and select the "Desktop" command.

Or click the "Add Desktop" button on the bottom left of Infront Professional Terminal.

Select "Blank Desktop" to create your own desktop, or load an existing desktop and customize it to suit your 
needs.
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When saving a workspace, all open desktops are stored in the workspace file.

Open desktops show up as tabs in the bottom left-hand corner.

3.5.2 Keyboard shortcuts
To switch between desktops, just click the corresponding tabs. Or use the keyboard shortcuts <ALT>+<1>, 
<ALT>+<2> and so on.

To move a window from one desktop to another, pin the window and change desktops, then unpin the 
window.

3.5.3 Change the order of the tabs
There are 3 menu options that allow you to freely move desktops around. These are available by right-
clicking the "Desktop" tab, or by using keyboard shortcuts.

"Move desktop" will prompt you for a new desktop number for the desktop.

The "Move desktop left" (<CTRL>+<SHIFT>+<PAGE UP>) and "Move desktop 
right" (<CTRL>+<SHIFT>+<PAGE DOWN>) commands can be used to quickly move a desktop to another 
position.

When running in floating mode, the tabs are just below the top tool bar.
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3.6 Workspace

See also:

Workspace layout
Link windows
Right-click menus
Window settings menu
Share window
Alert and alert manager

3.6.1 Workspace layout

Floating mode vs standard mode
The Infront Professional Terminal was traditionally a Multiple Document Interface (MDI) application 
(standard mode).

In the standard mode, there is one large main window that contains all the individual windows (such as 
markets, orderbooks, watchlists and charts). This makes it very easy to use, but it does limit the flexibility in 
where you can place windows and external applications. To overcome these limitations, we introduced an 
optional mode, the floating mode. In the floating mode, each individual window can be dragged across 
multiple screens and is not confined to one large main window.

Enable floating mode
To enable floating, go to the "⋮" menu on the top right, and select "Settings". Under "Workspace layout", 
select the "Floating (windows can be dragged across multiple screens)" option.

You need to restart the Infront Professional Terminal for the changes to take place.
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We recommend placing the toolbar at the top of your monitor so that it is easy to find.

3.6.2 Link windows

Description
Linking windows allows you to view a lot of information on many instruments quickly without having to 
open any new windows. Just type the symbol code or double-click a symbol to change the content in the 
linked windows.

Linking windows one by one
Open the window you want to link and click the "Link Window" icon on the right of the window title bar. Do 
the same for all windows you want to link.

The "Link Window" icon now displays the number of the link group. In the screenshot below, it is linked to 
group 1.

Link windows by group
To create different groups of linked windows, use one preferred channel for each group.
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Link all groups
If groups of linked items are needed in addition to having some windows linked to everything, you can use 
the "All Link Groups" selection for those specific windows.

Example
The groups do not affect one another.

Double-clicking CARL B in the watchlist will change the chart and the orderbook to show data for CARL B.

Double-clicking CAT in the market window will change the historical prices to show data for CAT.
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3.6.3 Right-click menus
Right-click any symbol to access the menu options for the given symbol. For example, right-clicking the 
ticker "CAT" opens the following menu.

If you right-click a particular feature, you get a menu allowing you to change settings or make changes to it. 
For example, you can right-click the y-axis of a chart to open a menu.

It's also possible to right-click any window in the Infront Professional Terminal to access the different 
options.

3.6.4 Window settings menu
Most windows in the Infront Professional Terminal have a "⋮" tools menu in the top right corner for quick 
access to settings of the current window.

Below is an example of the tools menu from the "Company" window:
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Commands common for all window menus
Clone This Window
Add as Favorite
Share
Edit Colors and Fonts
Window
Help

Clone This Window
Creates a duplicate of the current window.

Add as Favorite
Adds the window as a favorite. Favorites are available from the main menu on the very right.

Share
For more information, see Share window.

Edit Colors and Fonts
Change colors and fonts for different windows.

Cloning a window will result in a window of the same size. While the window is selected, type to 
search for another instrument. This makes it easy to add a lot of information to your workspace 
quickly.
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1.

Window

Element Description

Show Extra Information Clear this command to collapse the bar showing additional 
information.

Press <F11> or select the command from the menu to display 
the bar again.

Show Caption Cancel the selection to hide the title bar of the window.

Press <F12> or select from the menu to display it again.

Pin Window You can force a window to stay on the screen for all desktops 
(see Desktop). This is useful for windows that you always 
want to see - no matter which desktop you move to.

Help
Opens the online help for this window.

3.6.5 Share window
You can easily share any window in the Infront Professional Terminal with friends and coworkers.

The "Share" command creates a link, an e-mail or a tweet which allows you to share the content of the 
window with other users. A screenshot of the window will be generated. Also, underneath the screenshot of 
the window, a link will be generated allowing any user of theInfront Professional Terminal to open the same 
window in their installation of the Infront Professional Terminal.

To share a window:

Open the window you want to share.
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2.
3.

1.
2.
3.

Click the "⋮" settings menu on the upper right of the window.
Select "Share".

You can either share your window via an URL link, e-mail or on Twitter.

You can also use the <CTRL>+<ALT>+<S> keyboard shortcut to open the "Share" menu.

Using the URL link to share the window will allow anyone to see the window you shared in a browser. 
Additionally, other users of the Infront Professional Terminal can use the URL to open the window in the 
Infront Professional Terminal (providing they have access to the same services). This is a great way of 
communicating about the changing market situation.

3.6.6 Alert and alert manager

Create an alert
To create an alert:

Right-click the symbol you want to create an alert for.
Select "Create Alert" and the type of alert.
This opens the "New Alert" window. Select the relevant settings for your alert.

Alerts inform you when certain price movements have happened for a given symbol, chain or watchlist. The 
Infront Professional Terminal monitors these for you around the clock and informs you as soon as they 
happen.

Alerts in the Infront Professional Terminal
In the Infront Professional Terminal, a small notification is displayed alerting you that one of your alerts has 
been triggered.
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1.
2.

Alerts by e-mail
You can also receive alerts by e-mail.

Alerts on Mobile
If you have Infront Mobile, and you login with the same user as the Infront Professional Terminal, then you 
will also receive push notifications to your device.

Alert Manager
You can access the "Alert Manager" by clicking the "Bell" icon in the upper right corner of the desktop and 
then click "Manage my alerts".

The "Alert Manager" will allow you to edit and delete your alerts, look at you notifications as well as change 
your e-mail.

News Alerts
News alerts are only available in the Infront Professional Terminal and are not available via e-mail or on 
your mobile device.

You can define a list a news alerts for a "News" window.

To create an alert:

Open a "News" window.
Right-click an item and select "Add alert", which will open the "News Alert" list for the window.

The alerts belong to the specific "News" window open in your workspace. Closing this window will 
remove the alerts.
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Element Description

Conditions Specify if the alerts should apply to all the sources or to 
more than the ones selected.

Text in headline Specify if the news has a certain word, or combination of 
words in the headline.

Symbol tickers Define if a news source indicates that the news article is 
related to one of the symbols specified.

Classifications & Geographical areas Some premium news sources include data which 
classifies the news articles.

You can use these filters to only get alerts when a 
specific classification or geographical area is triggered.

Actions When the alert is triggered, you can define the alert 
actions.

3.7 Keyboard shortcuts
To make using the keyboard more efficient, Infront Professional Terminal provides various keyboard 
shortcuts. You can use these keyboard shortcuts to perform the most important functions.

Shortcut keys are displayed in this documentation as uppercase letters in angle brackets, for example 
"<CTRL>+<P>".

Keys that need to be pressed simultaneously are linked with a "+".
<CTRL> is the "Control" key at the bottom left of your keyboard.
<DEL> is the "Delete" key.
The <SHIFT> key switches between uppercase and lowercase.
The <F> keys are the function keys at the top of the keyboard.

The alerts apply to the news feeds configured for 
a specific window and will be saved with the 
workspace.

In addition to the comprehensive user manual, you can also find a compact PDF document 
(Keyboard shortcuts overview.pdf) with all the important keyboard shortcuts for quick download in 
the "Downloads" section.
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See also:

Keyboard shortcuts in all windows
Main menu commands
Search and search commands
Chart window
Market window/watchlist
News window
Trading shortcuts
Other

3.7.1 Keyboard shortcuts in all windows
Keyboard shortcut Function

<CTRL>+<P> Print content of current window

<CTRL>+<C> Copy to Clipboard

<CTRL>+<W> Clone current window

<CTRL>+<A> Select all

<F11> Toggle extra information

<F12> Toggle title bar

<SHIFT>+<F11> Toggle extra information in all windows

<SHIFT>+<F12> Toggle title bar in all windows

<ALT>+<1>
<ALT>+<2>...

Select specific desktop

<ALT>+<F>+<1>
<ALT>+<F>+<2>...

Select specific workspace

<CTRL>+<PAGE DOWN> Go to next desktop

<CTRL>+<PAGE UP> Go to previous desktop

<ALT>+<PAGE DOWN> Move active window to next desktop

<ALT>+<PAGE UP> Move active window to previous desktop

<CTRL>+<SHIFT>+<PAGE UP> Move desktop left
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Keyboard shortcut Function

<CTRL>+<SHIFT>+<PAGE DOWN> Move desktop right

<ESC> Close selected window

<F4> Search to change contents in window

<CTRL>+<ALT>+<S> Share window

<CTRL>+<ALT>+<F> Add as favourites

<F1> Help

3.7.2 Main menu commands
Keyboard shortcut Function

<ALT>+<G> Explore menu 

<ALT>+<M>
<ALT>+<D>

Tools menu 

<ALT>+<A> Analyse menu

<ALT>+<T> Trade menu

<ALT>+<R> Favourites menu

<ALT>+<O> Tools

<ALT>+<W> Workspace

<ALT>+<I> Windows

<ALT>+<H> Help
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3.7.3 Search and search commands

Search

Keyboard shortcut Function

<CTRL>+<F> Search anything

<CTRL>+<M> Search markets

<CTRL>+<N> Search news services

Search commands

Discover

Command Function

Calendar Opens economic calendar

Twitter Opens Twitter in browser

Custom list Opens custom list

Chart Intraday chart

Intraday Chart Intraday chart

HistChart Historical chart

Orderbook Orderbook

News Symbol news

News Service News search

Trades Opens trades for a symbol

BrokerStats Broker statistics

Focus Focus window

Symbol Symbol overview
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Command Function

Market Search markets

Feed All feeds (market, news, etc)

Page Pre-made views

Chain Market chains

Index Index overview

FX calculator Forward calculator

Forex Cross Table Forex cross table

Fund Fund overview page

Fund Screener Funds search functionality

Analyse

Command Function

Factsheet Company factsheet

Analytics Fundamentals

SME Estimates Consensus estimates

General

Command Function

Help Help guide

Support Mail to support

Preferences Advanced Settings

Exit Exit application

About About page
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Command Function

Menu Main menu window

Desktop Desktop choice page

Alert Alert manager

Shortcuts Shortcuts PDF file

Excel Link to templates and FAQ

3.7.4 Chart window
Keyboard shortcut Function

<CTRL>+<I> Intraday chart

<CTRL>+<H> Historical chart

<INSERT> Add study

<CTRL>+<P> Percent change

3.7.5 Market window/watchlist
Keyboard shortcut Function

<CTRL>+<SHIFT>+<M> Open new market window

<CTRL>+<SHIFT>+<C> Open new watchlist

<CTRL>+<INS> Add symbol to list

<DEL> Delete symbol in list

<CTRL>+<DEL> Delete column

<CTRL>+<UP ARROW> Move symbol up

<CTRL>+<DOWN ARROW> Move symbol down
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Keyboard shortcut Function

<CTRL>+<E> Copy DDE links

<CTRL>+<R> Copy RTD links

<CTRL>+<SHIFT>+<I> Open index constituents

<CTRL>+<L> Add symbol alert

<F9> Toggle summary bar

<CTRL>+<D> Orderbook for a symbol

<CTRL>+<O> Company overview

<CTRL>+<SHIFT>+<F> Focus window

Double-click shortcuts in Market window and Watchlist
In the "Market" window and the "Watchlist" window, double-clicking certain columns will open the following 
windows:

Column Function

Last column Open trades

Ask column Place a buy order

Bid column Place a sell order

Symbol column Open quote overview

L+/- column Open fast chart intraday

Column heading Change sorted column

Low column Historical Chart

Infinancials column Fundamentals

High column Historical prices

News column News for symbol
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Column Function

Historical change column Performance

3.7.6 News window
Keyboard shortcut Function

<CTRL>+<SHIFT>+<N> Open "Select News Service(s)" window

<CTRL>+<L> Add news alert

<ENTER> Read news story

<CTRL>+<DEL> Hide news item

3.7.7 Trading shortcuts
Keyboard shortcut Function

<CTRL>+<SHIFT>+<O> Select Trading Service

<CTRL>+<K> Click trading

<CTRL>+<T> Trades

<CTRL>+<D> Orderbook

<+> Buy order

<-> Sell order

3.7.8 Other

Calendar

Keyboard shortcut Function

<CTRL>+<SHIFT>+<A> Open new "Calendar" window
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Alerts

Keyboard shortcut Function

<CTRL>+<L> Open "New Alert" window

<CTRL>+<SHIFT>+<L> Open "Alert Manager"

SME Direkt

Keyboard shortcut Function

<CTRL>+<SHIFT>+<H> Chart for the selected symbol

<CTRL>+<SHIFT>+<Q> Details for the selected symbol

<CTRL>+<SHIFT>+<S> Consensus estimates

Quote overview

Keyboard shortcut Function

<CTRL>+<Q> Overview

<CTRL>+<SHIFT>+<W> News

<CTRL>+<T> Trades

<CTRL>+<D> Orderbook

Workspace

Keyboard shortcut Function

<CTRL>+<S> Save workspace

Broker statistics

Keyboard shortcut Function

<CTRL>+<B> Open broker statistics 

(available for SSE, CSS, HSS, TRS, BDM only)
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Keyboard shortcut Function

<CTRL>+<SHIFT>+<B> Broker statistics for the selected symbol

Communication status

Keyboard shortcut Function

<CTRL>+<ALT>+<M> Communication status
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4 Settings
Learn about the many setting options in the Infront Professional Terminal.

See also:

Account Setup
User interface
News
Trading settings
Alerts
Option Calculator
Advanced
Configuration settings

4.1 Account Setup

4.1.1 Open Advanced Settings
To open the "Advanced Settings", open the "⋮" settings menu on the top right, then select "Tools" and 
select "Advanced Settings".

4.1.2 Account Setup
The "Account Setup" dialog consists of 4 subcategories.

4.1.3 Login
In addition to the user name and password from the settings window, you can enter the IP address and port 
information here.

If the firewall is blocking the access to the Infront Professional Terminal, try to change the port to any of the 
following below and restart the Infront Professional Terminal:

80/tcp
443/tcp
11111/tcp
40000/tcp 
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4.1.4 Proxy

Element Description

Automatic Configuration This is used if your network administrator supplies an 
automatic configuration script (with proxy information, usually 
PAC files or similar).

Proxy Settings Here, you can configure the proxy settings.

These settings are for advanced users only. Consult your network administrator if possible.
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Element Description

Firewall Login Add your user name and password if you use a local firewall 
that requires a login for outbound connections.

4.1.5 Folders
Specifies where various data from Infront Professional Terminal should be stored. The folders must be 
unique and the defaults are usually sufficient for most users.

4.1.6 Web Proxy
Used for Twitter login details and Twitter proxy settings.

4.2 User interface
The user interface setup consists of 9 subcategories.
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4.2.1 General

Here, you can configure the following elements:

Element Description

Visual

Floating windows Enables the floating mode when selected.

Snap windows Every nth pixels: a feature to make it easier to place windows 
next to each other correctly.
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Snap windows loaded from workspace Same function as above, but it will snap all the windows 
together when you load a workspace.

Enable minimizing of windows Adds the "Minimize" icon in all windows.

Open orderbook page in symbol 
window

Opens the "Orderbook" (OB) tab by default instead of the 
"Overview" tab when opening an "Overview" window 
(<CTRL>+<Q>).

Content colors Allows you to change between color themes.

Trade ticker coloring relative to Changes the trades list (time and sales) colors for up and 
down.

The trades below are colored red because the prices are lower 
than the previous close in the example below.

Adjust time to Local / Feed / GMT / Unadjusted

Performance

Maximal number of intraday points The maximum number of prices or last values to be displayed 
in a chart.

Maximal number of search results Limits the number of search results.
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Just-in-time loading of market data If you have several desktops open, the terminal will not load 
market data on them until you view them.

Market Calendar

Show automatic at Set a time at which you want the "Market Calendar" window 
to open.

Auto-restart when no activity at If there is no user activity (no mouse or keyboard activity 
detected in the last 4 minutes), then the Infront Professional 
Terminal automatically restarts, saving and restoring the 
current workspace at the time you specified, for example at 
20:00 (8 P.M.).
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4.2.2 Grids

 

Select the relevant checkboxes to display grid lines, grid hints and alternate grid colors on rows or mark 
selected row.

Element Description

Grids

Show grid lines Displays grid lines in tables to clearly separate rows and 
columns.

Show grid hints Shows hints with more information for certain data fields 
you hover over.
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Element Description

Grids

Show detailed symbol hints Shows an informative hint with a chart for the symbol you 
hover over.

Alternate grid colors every x rows Applies different colors to alternate rows.

Indicate selected row Marks the selected row.

Highlight today's up/down on entire row Sets the font color for the entire row to the corresponding 
up/down color and not just the +/- columns which is the 
default.

Line spacing Refers to the space taken by each row in a market window, 
news window, custom lists and orderbooks. You can 
increase the spacing to improve readability or decrease to 
save space.
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4.2.3 Charts

Element Description

Chart performance

Fast chart 
updating

When there are too many data points in the chart relative to the space available, 
some periods in the chart may be drawn on top of neighboring periods. This setting 
provides a performance improvement when such is the case.

Fast candlestick 
charts

Adjusts the resolution of the chart (1, 10, 15 minutes intervals) so that all the data 
points for the time period selected can fit in the chart window. Turn on for a 
performance improvement.
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Anti-aliasing Smoothing of jagged appearance of charts. Turn off for a performance 
improvement.

Transparent fill Area charts are partially transparent. Turn off for a performance improvement.

Drop symbol on 
chart with 
<CTRL> key 
down

This setting controls what type of compare chart you get if you hold down the 
<CTRL> key when dragging and dropping a symbol into the chart.

Cursor

Automatic follow 
mouse

When moving your mouse across the chart, a visual grid cursor will update the date/
time and price on the x and y axis.

Snap to graph Combined with "automatic follow mouse", switch this setting off to only see a visual 
grid cursor for date/time on the x axis. Example below with this feature switched off.

Style Choose between a "vertical and horizontal" cursor (crosshair) or only a "vertical" 
cursor.

Other

Use annotation 
zoom

If switched on, it is no longer necessary to hold down <CTRL> to draw annotations in 
charts.

Print charts with 
screen-colors

By default, the charts will optimize ink usage by printing with a white background. 
Switch this setting off if you wish to print with the same colors as the screen is 
showing.
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4.2.4  Market Data

Element Description

Consolidation

Use consolidated markets (where available) Automatically switches on consolidated data for users 
with access to alternative marketplaces such as MTFs.

Support separate unconsolidated markets 
(where available)

Instead of consolidating market data to one market 
place, switching this option on will give access to the 
unconsolidated feeds separately.

Market
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Calculate yesterday's +/- values Show yesterday's +/- change while the market is closed.

Calculate pre-market +/- values When pre-trade Bid and Ask values match, this option 
calculates change (+/- and +/-%) values in the pre-
market period when there were no trades (and no last 
price).

This allows you to see where the market will open for 
each symbol that has pre-market orderbooks.

Separate tab for Indices in Market windows Move all indices from the "All Quotes" tab to a separate 
tab called "Indices".

Auto-save quote list per feed Automatically save the list you build up on the "List" tab 
in a market window.

Auto-save named Custom Lists If you have opened a previously saved custom list, any 
changes you make to it will automatically be saved.

Highlight when Last equals High or Low The last column in a market window or custom list will 
the change background color if the last price is the same 
as today's high or low.

Put / Call

Enable multiple selection of underlyings Allows the user to select more than one underlying 
instrument in the put/call tab for derivatives markets.

Put/call order Determine whether derivatives markets should be shown 
with calls on the left and puts on the right, or opposite.

Put/Call columns logic Normal mode shows default columns for derivatives 
market. "Include subtype" will add the subtype column.
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4.2.5 Regional

Select language and country

Infront Professional Terminal will try to detect an appropriate default country and language for your Infront 
Professional Terminal. If you want to change this, you can select a preferred default country and language.

The selected country is shown by default when opening some desktops in desktop builder. It also 
determines what country is shown at the top of the "Select Market" dialog and the "Select News" dialog.

Default conversion currency

The default currency used by the trading window as a target currency for conversion of your portfolio 
values.

Note that the list of countries only includes countries from which you have access to streaming 
quotes.
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4.2.6 Browser 

Choose internal or external browser and decide if you want to allow pop-ups or not.

4.2.7 Dialogs
Select the checkbox to restore all warnings and other information dialogs where you have selected "Don't 
show this message again."
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4.2.8 Searching

Quick-search fields

Element Description

Quick-search fields

Search type Select between "Full search" (ticker and instrument name) 
and "Ticker" when using quick search inside market 
windows, custom lists, charts, orderbooks and more.

Search scope Select whether the quick-search should search in:

All markets you have access to (slowest)
The same market (as the instrument you are looking at, 
fast)
Only in workspace (Infront Professional Terminal checks 
what is currently open in your workspace and searches 
through the markets, fast)

Searching result preferences

Prioritize consolidated markets Some users have static consolidated markets from the 
server. When this is available, the search results can be 
prioritized to display results from these markets first.

Exclude MTFs Select this checkbox to avoid seeing search results from 
MTFs such as BATS and Chi-X.
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Exclude asset types Removing asset types you never search for can help display 
results most relevant to you.

4.2.9 Signals

Element Description

Enable Signals For more information, see Signals.

Show "While away report" Infront Professional Terminal may detect interesting 
movements and events that occurred while you were away 
from your computer.

Show Signals Polar hints When holding your mouse over a given signal, the terminal will 
try to display a polar chart.
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4.3 News

4.3.1 News Defaults

Element Description

Symbol News Period Set the relevant period for symbol news in the "Symbol" 
window.
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4.3.2  RSS News Feeds

Add RSS news feeds to the Infront Professional Terminal and see them in a "News" window. Right-click in 
the news window, and then select "Sources". Then find the "RSS News Feeds" category and select your 
news feeds.
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4.4 Trading settings

4.4.1 Defaults

Element Description

Default volume Set the default board lots you wish to see in the "Order Entry" 
window. (A board lot is a standardized number of shares 
defined by a trading venue as a trading unit).

Default valid The number of days an order should be valid for.

Default order type When opening an "Order entry" window, this setting allows you 
to specify the default order type.

Default portfolio Useful if you have access to more than one portfolio.

Default active Orders can be sent as active or inactive to your trading service.

Default comment Some trading services allow for sending comments. Use the 
"Default comment" field if you want to include information in a 
comment by default.
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Element Description

Default broker Select your preferred broker.

Custom volume increment The volume field of an "Order Entry" window can be made to 
increase or decrease by a certain amount when clicking on the 
up and down arrows or using the up and down arrows on your 
keyboard.

4.4.2 Limits
Element Description

Limit per order Set the currency value per order as a limit. If you exceed the limit 
per order, the gross price field will highlight in red and you will 
receive a warning.

Limit per day As with the limit per order, you can also specify a currency value 
limit per day. You will also receive a warning.

Limits currency Set the currency of the limits.

4.4.3 Trading Alerts
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Element Description

Confirm order request If this checkbox is selected, you will be asked to confirm before 
the order is placed.

Fat finger alert Specify how far away from the current bid/ask spread the price 
you enter should be before it triggers a warning. This is useful 
to safeguard against typing in extra numbers by accident. For 
example , the user my have entered 2000 instead of 200 as the 
price.

Short selling warning Checks the volume of long positions in your portfolio for an 
instrument you are selling and warns you if you are selling 
more than you own.

Confirm order executed Get a confirmation when the trading service confirms your 
order as executed.

Tick size warning Warns you when the price you enter violates tick size rules of 
the trading venue.

Show alert on incoming care order Get an alert if a care order was received from the trading 
service.
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4.4.4  New Order Window

Element Description

Allow multiple windows By default, only one is shown in the Infront Professional 
Terminal.

Keep open When an order was placed, the default is to close the new "Order" 
window. Use this setting to keep the new order window open.

Set background color for buy/sell When placing a buy or sell order via the right-click menu or via 
keyboard shortcuts, the background color of the new order 
window will be colored green for buy orders and red for sell 
orders.

Shows advanced fields When opening a new order window, defines whether the 
advanced fields should be shown immediately or hidden until 
you click the "Adv" button.
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Element Description

Auto-expand advanced fields If the "Shows advanced fields" checkbox is cleared, tabbing with 
your keyboard through the new order window will make the 
advanced fields show up automatically after gross price.

Enable gross price field The gross price field is displayed in an order entry window. This 
option switches on the ability to type in your own gross price. If 
you have also entered a price, then the closest volume 
corresponding to the gross price will be calculated for you. In the 
example below, a price of 347 and gross price of 100,000 was 
entered. The terminal then calculated a volume of 288 
automatically.

Do not resize linked order windows In a compact workspace, it may be desirable to not resize the 
new order window when changing instruments.

Hit orderbook, Join orderbook When opening an new order window buy clicking the "BUY" 
button (or "SELL" button):

"Hit orderbook" will place the price at the best ask price (best 
bid price for SELL orders)

"Join orderbook" will place the price as the best bid price 
(best ask price for SELL orders)

Price Tick Size Factor (Available for FX RFQ trading only.)  When increasing or 
decreasing the price of a new order with the up and down arrows, 
this will multiply by a factor of X with the tick size rules.

Example: If the factor is set to 3, and the tick size is 0.0001, then 
clicking the up arrow on the price field will increase the price by 
0.0003.

Buy/Sell button When opening a new order window by selecting BUY or SELL 
from a right click menu or using keyboard shortcuts. This setting 
defines the behaviour of the BUY and SELL buttons.

"Normal": Both "BUY" and "SELL" buttons show up and 
function as normal.

"Make default": The "BUY" or "SELL" button (depending on 
what you choose) will be highlighted and pressing <ENTER> 
on your keyboard will cause the order to be placed.

"Disable other": Will show you but not allow you to click on 
the SELL button if you have chosen to BUY from the right-
click menu or keyboard shortcuts. Or it will disable the "BUY" 
button if you have chosen to sell.

"Hide other": If you have chosen "BUY" from the right-click 
menu or keyboard shortcuts, then the SELL button will be 
hidden. Or the the "BUY" button will be hidden if you have 
chosen to sell.
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Element Description

Hit on volume In orderbook

In new order

4.4.5 Trading Window
The "Trading Window" is where you can see all orders, trades and your portfolio positions.

Element Description

Trading Window

Allow multiple windows The default is to only show one.

Keep deleted orders If selected, deleted orders will also be shown on the "Orders" 
tab.
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Column filtering Allows the user to filter orders based on various criteria. 
Below is an example where it is possible to choose to only 
show portfolio positions in a particular currency.

Allow inline modification of order Allows the user to edit an order's price or volume by clicking 
in the field ("Orders" tab) without having to open an order 
window.

Show fractional prices For some markets, the convention is to use fractions instead 
of decimals.

Show Turn Order buttons For active orders, this feature allows you to change a buy 
order to a market sell order (turns sell orders to market buy 
orders). These buttons show up on the "Orders" tab.

Show Multiple Delete Buttons If this feature is turned off, then only one "Delete" button is 
shown. Select the order and delete it. If it is turned on, three 
extra options are available: "Delete Buy", "Delete Sell", 
"Delete All".

Blink for new orders New orders placed will blink on the "Orders" tab.

Blink for new partially filled orders Partially filled orders placed will blink on the "Orders" tab.

Automatically refresh portfolio When an order is placed or executed, check for updates to 
the portfolio.

Performance

Request market data Infront Professional Terminal will request the market data 
even if the user has not opened the market in their 
workspace. Turn this off for a small performance boost if 
you have a very large portfolio.

Live market data Enable live market data updates.

Support order VWAP column Show the VWAP column.
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4.5 Alerts

Element Description

Show Alerts for

Trading halt status When trading is halted by an exchange.

News event count-down Some news feeds support time-based releases.

Exchange open/close messages When an exchange is opening or closing.

General

Show notification window for The amount of time an alert should be visible for.

Quote alerts

Default double click action Defines what should happen when double-clicking a 
quote (price) alert.
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Market calendar alerts

Notify in advance When setting an alert for calendar events, Infront 
Professional Terminal can warn you in advance.

Push alerts

Alert me by email in addition to normal 
notifications

When an alert is triggered by activity in the markets, you 
can receive the notifications by email (watchlist and 
quote alerts only).

4.5.1 Trading alerts
See Trading Settings.

4.5.2 Sounds
Music, sound clips or any other type of audible alert can be used to notify you when trading related events 
have taken place. Wave (*.wav) files are supported.
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4.6 Option Calculator

4.6.1 Symbol Settings

Element Description

Underlying feed The settings will apply to all underlying symbols for the options feed 
you select.

Interest rate Many calculations require an interest rate in order to calculate the 
values. Specify an interest rate here you wish to use.

Selected Once you have selected some underlying symbols, you can set 
custom volatility periods, and have them recalculate automatically. 
Alternatively, set a custom value for volatility.
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Volatility
Volatility measures how much the underlying instrument is expected to change over time. This value is 
needed by the option calculations and must be set manually in this dialog.

Element Definition

Define Feed and symbols Select the feed and the underlying instrument. The list of feeds will 
only include the active underlying feeds of the currently loaded 
option feeds.

Define Interest rate Determines the basic risk-free rate for the market as a whole. This 
default value is 5%.

Set Volatility Select symbol(s) in the list and click the "Set Volatility" button to 
change the volatility value. This requires that you have determined 
a preferred volatility value for each underlying symbol. 
You can alternatively have the server calculate a historical volatility. 
The server calculates the actual volatility of the underlying 
instrument for the last number of days. 20 days is used as default, 
but you can override this by selecting the symbol(s) and clicking 
the "Set Days" button. When you are ready, select the symbol(s) and 
click the "Calc Volatility" button. 

The "Select All" button easily lets you select all the underlying 
symbols in the list. 

Dividends If the company of the underlying instrument is planning to pay 
dividends in the future (but before the option expires), this will 
influence the option price. To ensure that the calculations are 
adjusted accordingly, enter the dividend date and amount here. 
Each underlying instrument may have any number of future 
dividends registered. Only dividends inside the expire period will be 
considered during the calculations.

Use the "Add" button to add new dividends.

Use the "Delete" button to remove a dividend.

Calculating the historical volatilities may take some time.

Calculating the historical volatilities may take some time. 
You may close the "Option Calculation Setup" dialog, and 
the volatilities will still be calculated and updated correctly 
as they are received from the server. You will get a 
notification about this, but this message can be 
suppressed in the future by checking the "Don't show this 
message again" checkbox.
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Element Definition

Calculation Methods The option calculation engine supports three different option 
models. Each method is used for different kinds of options as 
indicated by the default values in the dialog.

Black & Scholes This is option-pricing model was first introduced by Fischer Black 
and Myron Scholes in 1973. It is used for European options (such 
as the OBX options on Oslo Options). European options cannot be 
exercised before the expire date.

Binomial John Cox, Stephen Ross and Mark Rubinstein introduced the 
Binomial Option-pricing Model in 1979. It is used for American 
options (such as the NHY options on Oslo Options). American 
options can be exercised any time up to and including the expire 
date.

Black & Scholes-76 This option-pricing model is a variation of the standard Black & 
Scholes model, and was presented by Fischer Black in 1976. This 
model is used when the underlying instrument is a futures contract.

Limits The option calculation engine will produce results of a specific 
accuracy. The minimum acceptable accuracy can be specified here. 
Also, the engine relies on iterating through a number of 
calculations, increasingly finding a more accurate answer. The 
maximum number of iterations can also be set here.

4.7 Advanced



Infront Professional Terminal – Settings

04/25/2022 113 / 258

The "Advanced" tab contains instructions on the requirements of running the option calculations. You can 
clear the "Enable Option Calculations" checkbox on the "Advanced" tab if you don't want to have these 
calculations executed.

Element Description

Enable Option Calculations If enabled, Infront Professional Terminal will calculate 
"greeks" using the specified pricing methods.

Limits Settings for the various option pricing methods.

4.8 Configuration settings

4.8.1  [IAS] Section - Login details
The "IAS" section in the ontrade.ini  file contains configuration details used to connect to the IAS (Infront 
Access Server) and login to the system. Some of the settings are related to handle connections through 
proxy servers.

[IAS]

UserName=<username>

Password="<shuffled password>"

Address=login2.goinfront.com

Port=443

OwnerProviderID=123

ProxyAddress=

ProxyPort=80

ProxyUserName=

ProxyPassword=

ProxyID=0

ProxyType=1

UsePACFile=0

PACFileAddress=

These settings can be edited by the user by opening the "⋮" menu on the top right > "Tools" > "Advanced 
Settings" > "Login" in the "Account Setup" category page.

4.8.2 [FILES] Section - Folder paths
The "FILES" section in the ontrade.ini  file contains information about what folders to use for different 
storage files.

[FILES]

Cache=C:\Users\Username\Documents\OnTrade\Cache

Workspace=C:\Users\Username\Documents\OnTrade\Workspace

Setup=C:\Users\Username\Documents\OnTrade\Setup
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Portfolio=C:\Users\Username\Documents\OnTrade\Portfolio

MarketPages=C:\Users\Username\Documents\OnTrade\MarketPages

SharedScreens=

These settings can be edited by the user by opening the "⋮" menu on the top right > "Tools" > "Advanced 
Settings" > "Folders" in the "Account Setup" category page.

4.8.3 Workspace folder
The "Workspace" folder contains the workspace files that the user has saved ("File" > "Save Workspace"). 
The default workspace is named "Default.wksp". Each workspace is stored in XML format in a file with 
".wksp" as extension.

4.8.4 Setup folder
The "Setup" folder contains files with various global settings and named symbol files.

The following table summarises what content is stored in the Setup folder:

Element Description

*.bol Basket trading order list

*.BrokersGrid.col Saved BrokerStats column layout files

<feednr>.col Default columns for market windows (per feed)

*.MarketGrids.col Saved market window column layout files

ChartDefaults.ini Defaults for new chart windows (Chart Setup)

GraphDefaults.ini Default for each study (Study properties)

lines_<feednr>_<ticker>_*.ini Old 4.4 per symbol chart trendlines

*.tof Per symbol chart annotations in new 4.5 XML 
format

colors.dat Global per window type colors (Edit color)

*.filter Saved news window filter in XML format

*.OrdersView.gv Saved column layout from "Trading" window

IgnoreChat.lst List of chat nicks the user ignores
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Element Description

<feednr>.ontrademylist Market window symbol list (per feed, List page) in 
XML format

*.sl Named symbol list in XML format

ChatAlerts.str Chat alerts

OrderEntry<providerid>_<serviceid>_<YYYYMonD
D>.log

Log of trading activity (per provider and date)

4.8.5 Portfolio folder
The "Portfolio" folder contains files with information for the standalone "Portfolio" window (not the 
"Portfolio" page that is part of the "Trading" window).

The following table summarises what content is stored in the "Portfolio" folder:

Element Description

*.gv Column layout for Portfolio window (per named portfolio)

*.pse Configuration settings for portfolio (Portfolio Setup)

*-Trades.TR2 Cache of last Trading trades (per trading login)

*.trd Portfolio contents, with all assets

4.8.6 Cache folder
The "Cache" folder contains temporary cached information. Caching information in these files can reduce 
the time and bandwidth used to download large, but slow moving information such as history, instrument 
static information and so on. You can delete the contents of the cache with the "Tools" > "Delete Cache" 
command.

The following table shows what is stored in the "Cache" folder.

Name Description

<feed><ticker>*.HST Historical prices (per feed/symbol)

<feednr>_<providerid>.SYM Static symbol information for full feeds (per feed)
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4.8.7 MarketPages folder
The "MarketPages" folder contains files to support the "Market Pages" functionality.

The following table shows what content is stored in the "MarketPages" folder.

Name Description

marketpages.ini List of all Market Pages files that should be available for 
everyone

marketpages_<providerid>.ini List of all Market Pages files that should be available for 
provider's users

*.html The HTML contents of a single Market Page

*.gif Graphic logos, images etc referenced from HTML files

4.8.8 [OptionCalc] Section - Option Calculator settings
The "OptionCalc" section in the ontrade.ini  file contains configuration details used during option 
calculations.

[OptionCalc]

Enabled=0

EuroOptionMethod=0

AmericanOptionMethod=2

FutureOptionMethod=1

Accuracy=0.01

BinomialSteps=50

MaxTries=50

In addition the "Option Calculator" module uses settings stored per feed and underlying, like this:

[18177]

IntRate=0.061

[18177_DNBNOR]

Volatility=0.7429

VolatilityDays=20

[18177_NHY]

Volatility=0.5656

VolatilityDays=20

These settings can be edited in the "Tools" > "Option Calc" dialog.
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4.8.9 [Workspace] Section - Last used files
The Workspace section in the ontrade.ini  file contains a list of the 5 last used workspace files. This 
information is used to populate the workspace list on the "File" menu and the "Open toolbar" button drop-
down.

[Workspace]

File0=C:\Users\Username\Documents\OnTrade\Workspace\Default.wksp

File1=C:\Users\Username\Documents\OnTrade\Workspace\Click1.wksp

File2=C:\Users\Username\Documents\OnTrade\Workspace\DefaultFlatLine.wksp

File3=C:\Users\Username\Documents\OnTrade\Workspace\ModifyNewsTest.wksp

The list of files are updated each time you open a new workspace.

4.8.10 [Portfolio] Section - Last used files
The "Portfolio" section in the ontrade.ini file contains a list of the 5 last used portfolio files. This information 
is used to populate the portfolio list on the "⋮" settings menu > "Workspace".

[Portfolio]

File0=C:\Users\Username\Documents\OnTrade\Portfolio\Private.pse

File1=C:\Users\Username\Documents\OnTrade\Portfolio\test2.pse

File2=C:\Users\Username\Documents\OnTrade\Portfolio\test3.pse

The list of files are updated each time you open a new portfolio.

4.8.11 [OrderEntry] Section - Trading settings
The "OrderEntry" section in the ontrade.ini file contains configuration details used by the trading module.

[OrderEntry]

LimitPerOrder=0

LimitPerDay=0

DefaultValidDateIndex=0

VolumeDecimals=0

PriceDecimals=2

AvgPriceDecimals=4

DefaultPortfolio=HVTest

DefaultOrderType=otNormal

DefaultPortfolioFrom=dpfSpecific

KeepOrderEntryOpen=True

AllowMultiOrderEntry=True

AllowMultiOrderStatus=True

BuySellButtonUI=bsMakeDefault

OrderbookSummary=True

OrderbookSummary2=False
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OrderbookMarketMaker=True

OrderbookAveragePrice=False

OrderbookAccumulatedVolume=False

OrderbookHeadings=True

OrderbookVolumeBars=True

OrderbookFull=True

ShowAdvanced=False

AutoExpandAdvanced=True

AllowValueEdit=True

ShowCommentFilter=False

FixedOrderEntryPosition=False

HitOnVolumeOption=hvNo

HitAsOrderType=otNormal

MarketPriceLogic=mplLast

ColumnFiltering=True

DefaultActiveOrder=True

FatFingerAlert=True

FatFingerPercent=0.1

SetBuySellBgColor=True

ShowHistoricTrades=True

KeepDeletedOrders=True

DefaultComment=

EnableBasketTrading=True

AllowMultiBasketTrading=False

BasketPosition=bpBuy

BasketPriceSource=psAsk

DistributeRounding=brDownBoardLot

DefaultVolumeBoardlots=0

MaxHistTradeDays=7

PlaySoundAlerts=True

SoundBuyOrderPlaced=drip.wav

SoundSellOrderPlaced=drip.wav

SoundRejectedOrder=buzzer2.wav

SoundBuyTradeExecuted=doink.wav

SoundSellTradeExecuted=doink.wav

AllowPartialParentOrders=False

InternalOrderWarning=True

InternalTradeWarning=True
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ConditionalSingleClick=True

ConditionalPriceDeltaInTicks=2

ConditionalOrderType=otNormal

SingleClickHints=True

HitOnVolumeOrderEntry=hvNo

DefaultBroker=

SupportOrderVWAP=False

SupportRequestMarketData=False

SupportLiveUpdatesMarketData=True

OrderbookYields=False

OrderbookBlinkOnChange=False

OrderbookHighlightLevelCnt=1

OrderbookSectionSeparator=False

LimitCurrency=SEK

DeleteOrderShortcut=0

BoardLotWarning=True

TickSizeWarning=True

UseVolumeLot=True

VolumeLotValue=10000

VolumeLotCurrency=NOK

VolumeLotRoundTo=100

PriceThresholdWarning=True

These settings can be edited by the user by opening the "⋮" menu on the top right > "Tools" > "Advanced 
Settings" > "Trading".

4.8.12 [MarketPages] Section - Market Pages cache
The "MarketPages" section in the ontrade.ini  file contains information about automatically downloaded 
"Market Pages" files.

[MarketPages]

logo_tullettprebon.gif=20070913

tullettprebon_eur_composite.html=20080405

tullettprebon_EONIAOIS_composite.html=20071211

tullettprebon_nok_composite.html=20081105

tullettprebon_sek_composite.html=20081105

4.8.13 [CustomSymbolLinks] Section - Per symbol links
The "CustomSymbolLinks" section in the ontrade.ini file can be used to configure web- or application links. 
These links will be available in the right-click, symbol menu.

[CustomSymbolLinks]
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Open Notepad=notepad.exe

Infront.no=http://www.infront.no/

Oslo Stock Exchange,0=http://www.oslobors.no/markedsaktivitet/stockOverview?newt__ticker=*ticker*

The text on the left side of the equals sign will be used as the menu item caption. The right side contains 
the path and name of the application or the full URL of the web page you want to link to.

By default the links will appear directly in the top-level symbol menu and they will open external browser 
windows. It is possible to override this by ending the caption with a comma (,) and a numeric value. For 
instance, using 0 as above the Oslo Stock Exchange link will appear in the Web-links sub-menu and open 
an internal browser window.

Web links may use field codes surrounded by asterisk (*) to include dynamic information from the selected 
symbol.

4.8.14 [Clocks] Section - Toolbar clock configuration
The "Clocks" section in the ontrade.ini file contains configuration for the different time-zone clocks you can 
display on the toolbar.

[Clocks]

Clock0TZ=Romance Standard Time

Clock0Cap=Time

Clock0Sec=1

4.8.15 [Settings] Section - Misc. settings
The "Settings" section in the ontrade.ini file contains miscellaneous settings.

[Settings]

ROtest=canwrite

HelpFileName=ontradeENG.chm

AliasName=TOT-Vassbotn

CertificatesPath=C:\Svnpas\Apps\TOT\Cert\*.cer

4.8.16 ROtest
The "ROtest" value is just used to test that the application has write access to the ontrade.ini file.

Name Description

HelpFileName Saves the last used help file.

AliasName Stores your selected Chat module nick name.

CertificationPath Used for providers that require a client certificate to be present 
on each client machine.
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5 Trading
Learn how to use the trading functionality in this chapter.

See also:

Trading login
Guide to trading
Order types
Click Trading
Multibroker
Trading window
Export of orders and trades
Trade ticker
Basket trading
Algo trading
Smart orders

5.1 Trading login
To trade in the Infront Professional Terminal, you need additional credentials for the Trading gateway. You 
should receive these credentials from your broker.

To log in to trading via the Infront Professional Terminal:

Go to the main menu.
Select "Tools".
Select "Trading" under "Trading".
Select the "Trading" service you use (that is, the broker) and enter the credentials you received from 
your broker.
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5.2 Guide to trading

5.2.1 How to access
The "Trading" window is the main window for trading where you can see the full overview of all your orders, 
trades and the portfolios you have access to.

Open the main menu > "Tools" > "Trading" > and select your trading service.

The "Trading" window provides an overview of your portfolios, orders and trades.

5.2.2 Place an order
You can add an order in several ways:

Select the symbol from a watchlist, market window, or overview window. Then press the <-> or <+> 
key on your keyboard. The <-> key is for sell orders and the <+> key is for buy orders.
The second way is to right-click the symbol, then click "Trading" and then either "Buy" or "Sell". 
Fill in volume and then click "Buy"/"Sell".
Another way to place a trade is by using the "Infront Click Trader". For more information, see Click 
Trading.

5.2.3 Supported order types
The program supports different order types depending on the exchange, asset class and trading service.

Standard types: At market, Fill or Kill, Fill and Kill, All or nothing, Limit, Market to Limit, At Market and 
Kill
Depending on exchange: Contingent, Flex, Interest, Best Possible, Funari
Conditional orders
Direct Market Access or Care Orders
Request for Quote

5.2.4 Position keeping
You can have access to one or several portfolios. You can define your default portfolio or select a portfolio 
each time you place an order.

Each portfolio will give you an overview of all assets, limits and trading power.

5.2.5 Access to several portfolios
Depending on your trading account, you may have access to several portfolios. You can select between 
your different portfolios when placing orders.

It is also possible to retrieve account information for each individual portfolio.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=uy7AuKjqB2E
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5.2.6 Limits
Limits such as cash, trading power, shorting limits, credit limits and so on are defined by the account you 
are trading on. In addition, you can define your own limits in trading settings.

5.2.7 Basket trading window
The "Basket trading" window enables you to set default conditions or specify conditions for each order. For 
more information, see Basket Trading.

5.2.8 Slicing of orders (parent & children)
The program supports parent and child orders where you can either split an order to different accounts or to 
different brokers.

5.2.9 Trading algorithms
The program was developed to support trading on different algorithms provided by brokers. For more 
information, see Algo trading.

5.2.10 Smart orders
Some trading providers also support automatic trading a company on multiple exchanges, so called Smart 
orders.

5.3 Order types
The program supports most order types. The default order type is a "Normal order" where you define 
the price and the volume and send the order to the trading venue.
The specific meaning of each order type is subject to provider and market rules. Different types of 
orders can be sent to the trading system and trading place.

Order type Description

Normal Order An order where you define the price and the volume and send 
the order to the trading venue. Should the order not be 
completed in its entirety, then it shall remain in the market until 
it is filled or removed.

Fill and Kill Order An order to buy or sell that can be filled partially or cancelled. If 
the order cannot be filled in its entirety at the specified premium, 
then as much as possible of the order is filled and the rest is 
killed.

Fill or Kill Order An order to buy or sell that must be filled completely or 
cancelled.

The order types you have access to depends on the exchange and your broker.
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Order type Description

All or Nothing If the order cannot be filled in its entirety, the order will stay in 
the market.

Market Order An order to buy or sell a stated number of contracts at the best 
price available in the market. An order submitted at any time 
within a trading session, executable immediately at the current 
market price.

Limit Order An order to buy or sell a stated number of contracts at a 
specified price or at a better price.

Stop Limit Order An order to buy or sell when the market for a particular contract 
reaches a specified price. A Stop Limit Order to buy becomes a 
Limit Order when the relevant contract trades or is bid at or 
above the stop limit price.

A Stop Limit Order to sell becomes a Limit Order when the 
relevant contract trades or is offered at or below the stop limit 
price.

Stop Order An order to buy or sell when the market for a particular contract 
reaches a specified price. A Stop Order to buy becomes a Market 
Order when the relevant contract trades or is bid at or above the 
stop limit price.

A Stop Order to sell becomes a Market Order when the relevant 
contract trades or is offered at or below the stop price.

Market To Limit A Market to Limit order is submitted as a market order and 
executes at the current best market price. If the order is only 
partially filled, then the remainder of the order is cancelled and 
re-submitted as a limit order with the limit price equal to the 
price at which the filled portion of the order executed.

Good 'Til Cancelled Order (GTC) An order, unless executed, remains in the Trading System until it 
is withdrawn by the broker, trading venue or the person who 
placed it or the expiration date of the contract to which it relates, 
whichever occurs first.

Request Quote An order where you request the price for the instrument and the 
broker replies with a price that is  normally is valid only for a 
certain time, for example,15 seconds.

Iceberg Order Iceberg (reserve) orders allow you to submit an order (generally 
a large volume order) while publicly disclosing only a portion of 
the submitted order.
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Order type Description

Conditional Order / Monitor Order A Conditional order will not be activated to the market until one 
or more conditions are met that you have defined. Support for 
conditional orders is subjected to restrictions in the Trading 
Gateway.

Example: Trigger order only if Last is less than X and Bid higher 
than Y...

Calendar Spread A strategy which entails buying one delivery month of a contract 
and simultaneously selling another delivery month of the same 
contract on the same exchange.

Trailing Stop Limit Trailing stop limit orders work just like trailing stop loss orders, 
except that the order becomes a limit order (instead of a market 
order) when the order is triggered.

The limit price is the last stop price set before the order was 
triggered. The primary benefit of trailing stop orders is that when 
a customer establishes a trail amount on the security, the stop 
price adjusts with positive market activity. Trailing stop limit 
orders are available on Listed equities, OTC securities and 
single-leg options.

Trailing Stop Loss A trailing stop loss order is a stop loss order that adjusts in price 
with favourable market movement on the security.

Trailing stop loss orders follow the same trading principles and 
mechanics commonly associated with stop loss orders.

The primary benefit of trailing stop orders is that when a client 
establishes a trail amount on the security, the stop price adjusts 
with positive market activity.

For a trailing stop loss order to sell, the stop price moves up as 
the price of the security moves up. For a trailing stop loss order 
to buy, the stop price moves down as the price of the security 
moves down.

If the price of the security is moving against the client's order, 
then the stop price does not adjust.

Validity Today

The order is valid the entire day until close.

Closing auction only The order is valid only during closing auction.

Opening auction only The order is only valid during opening auction

Odd Lot Odd lot is the minimum accepted order in the market.
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5.4 Click Trading
With Click Trading, you can place an order in the market by simply clicking in the "Click Trading" window 
once, thus making it easier and more efficient for you to place trades.

Depending on what type of terminal you have, it might be necessary to add the "Click Trader" as an extra 
service if you do not have access. The access requirements are:

Access to trading
Access to "Click Trading" window
Access to Orderbook Data (level 2 data)

If you do not have access, please contact Infront or your broker.

5.4.1 How to open Click Trading
Right-click a symbol > Select "Trading" > Then select "Click Trading".
Or use keyboard shortcut: Select the instrument> Press <CTRL>+<K>.

5.4.2 How to use Click Trading
The view presents an ascending vertical list of prices centered between the current bid/ask levels. The 
outermost column displays all your active and pending orders in the selected portfolio. The "Bid Size" and 
"Ask Size" columns show the order depth volumes at their respective price levels. The middle column 
displays the price based on the tick size.

Element Description

Place an order Select the portfolio you want to trade on. Select the volume you 
want to place in the trading venue. Then click with the left 
mouse-button on the "Bid Size" (for buy order) or the "Ask 
Size" (for sell order) at the relevant price level.

Add multiple order at the same level Click several times in the Bid Size or Ask Size at a certain price 
level.

Cancel order Click the order in the "Buy" or "Sell" column.

Drag-and-drop The "Click Trading" window allows you to drag-and-drop from 
one level to another to change the price. Select the order you 
want to move. Drag it to a different price level (up/down). It is 
also possible to move an order from buy-side to sell-side and 
vice versa.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=Q5Pzardbxu8



Infront Professional Terminal – Trading

04/25/2022 128 / 258

Element Description

Enable "Gap" mode Gap handling allows you to remove levels in the order book 
where no orders have been placed. This is especially useful on 
instruments with very small tick sizes and big gaps between 
orders. To enable this, right-click in the "Click Trading" window 
> select "Gap mode" > select between "All", "One" or "None".

Lock the "Click Trading" window While the lock is enabled, it is not possible to enter orders in the 
"Click Trading" window. To enable the lock, right-click in the 
"Click Trading" window > click "Lock".

Setup menu In the "Setup" menu for the "Click Trading" window, you will see 
several optional settings, such as conditional orders (possible 
to define the order type), enable/disable hints, clear volume 
after sending order and more. To access the "Setup" menu, click 
the "⋮" three dots in the upper right corner of the "Click 
Trading" window > click "Setup". This opens another window, 
where you find settings under "Settings" and "Visual".
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5.5 Multibroker
In Infront Professional Terminal, the Multibroker function allows you to connect with different brokers in the 
same trading window that requires a customized login.

The Multibroker solution will encrypt and store the credentials of each trading access in a local file on your 
PC. The encryption is tied to the current Windows account. This will allow you to connect to all of your 
brokers available with one single login, making your trading easier and more efficient.
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5.5.1 How to create Multibroker credentials
Clicking the "⋮" system menu at the upper right corner of the desktop > select "Multibroker 
credentials".
Fill in the connection name of your choice and create a password that must follow the following 
rules: 

At least 8 characters in length.
Contains at least one uppercase character.
Contains at least one lowercase character.
Contains at least one digit.
Contains at least one special character.

Then add your preferred trading service to your Multibroker solution by clicking "Add" > click "Save" 
when you are done.

You can now log in by clicking the "⋮" system menu icon > log in to Multibroker and enter the credentials 
that you have created. Once logged in, you will have a secure connection to your broker or trading network.

The Multibroker login now appears as a separate trading service. This will make it easy and efficient to 
access all your portfolios in the same trading window.

5.6 Trading window
The "Trading" window is the main window for trading where you will have the full overview of all your orders, 
trades and the portfolios you have access to. You will need access to the Infront Professional Terminal and 
connection to your broker to get access to the trading window.

The window can be opened by clicking the main menu > "Tools" > "Trading". When the login window 
appears, enter the login and password provided by your broker. Note that this is not the same login as the 
one you use to log into the Infront Professional Terminal. After you have successfully logged in, the 
"Trading" window appears.

From the top of the "Trading" window, you can change your portfolio and target currency. The trading 
window has a total of 5 tabs.

You can also change the columns for each tab by right-clicking a column and choosing "Field chooser".

Field Description

Orders The "Orders" tab shows the status of all your orders. An order can be 
either active or inactive; an inactive order is not sent to the marketplace, 
while an active order is sent to the marketplace. As soon as the order is 
activated, it's sent to the exchange.

The right-click menu in the "Order" tab allows you to activate, modify, 
view or delete an order, or insert a new order.

Trades Trades displays all trades for the selected portfolio. Usually only 
intraday is available. This tab shows TradeID, symbol, volume, value, 
price and more for the executed trades.

You need access to the "Trading" module to access the Multibroker solution.
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Field Description

Net Trades Net trades will accumulate all buy and sell orders and show the net 
volume and values of all buy and sell orders per symbol.

Portfolio Portfolio shows positions in the currently selected portfolio. Portfolio 
values such as trading power, market value, total invested and so on are 
retrieved from the Trading Service. There may be more values shown 
depending on what the trading service supports.

Log All communication between Infront Professional Terminal and the 
Trading Services are logged on the "log" tab. To copy the log files, use 
the "Window tool menu" on the upper right of the window > "Edit" > 
"Copy", then paste the log to a text editor such as Notepad.

5.7 Export of orders and trades

5.7.1 Description
All orders, trades and portfolio information from the "Trading" window can be exported to files by selecting 
"Edit" > "Save as".

5.7.2 Formats
MS Excel files (XLS)
XML Files (XML)
HTML files (HTM)
Text files (TXT)

5.7.3 Scheduled export of orders and trades lists
This is an optional module that enables periodic automatic export of the orders and/or trades currently 
listed in the "Trading" window.

The exported data is the same that can be stored manually with the "Edit" > "Save as" command and 
supports 4 different formats: MS Excel, XML, HTML and Text.

5.7.4 How to access
The module must be enabled centrally with the package called "Advanced: Order Entry - Export Module". 
The functionality is available by selecting "Automatic Export" from the right-click menu in the "Trading" 
window.

5.7.5 How to use
When the dialog is displayed, there are a number of ways to configure how and when the export should be 
executed.
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5.7.6 General Settings
This is the configuration of the content. There are two checkboxes that you can use to select if to export 
trades, orders or both. The date drop-down list contains a pre-configured set of date formats that will be 
used when writing the export file. Finally, there is a drop-down list of the export format:

MS Excel files (XLS)
XML files (XML)
HTML files (HTM)
Text files (TXT)

5.7.7 Period
Drag the "Start export at" slider back or forth to set the relevant start time of the export, and do the same 
with "End export at". The automatic export will then work within this time frame every day as long as the 
export scheduled export job is active. In the "Export every" drop-down box, set how often the export should 
be executed within the time frame.

5.7.8 Export To
Each export operation produces a new file with a file name consisting of the portfolio name, date, time and 
orders or trades. In the "Edit" field, enter the target path for the export, or click the "Browse" button to open a 
dialog where you can select the folder. The file name preview will show an example of how the file name will 
look like with the currently selected settings. Click the "Export Now" button to execute an export manually.

If the configuration of the export schedule is OK, then click the "Start Job" button to start the automatic 
export. If the system is within the time frame, it will execute an export immediately and then a new one after 
the "Export every" setting. From now on, the schedule will be active until you click the "End Job" button.

5.8 Trade ticker

5.8.1 How to open
Open "Horizontal Ticker" or "Vertical Ticker" from the main menu under "Tools" > "Utilities".

5.8.2 Description
Similar to the "Trades" tab in the symbol overview, the trade ticker displays time and sales information. The 
trade ticker can show trades for many symbols from a number of markets and asset classes.

To show only trades in symbols from your watchlist, select the "Filter on My List only" checkbox.

The content of the export is from the portfolio selected in the "Trading" window.

Also, the "Trading" window needs to be kept open in order for the automated export to work.

The "Trading" window indicates that automatic export is enabled in the window caption text.

Clicking the "Export Now" button will only start the export once, it will not start the automatic job.
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5.8.3 Trade ticker setup
Setup is available from the window settings menu (press <F10>).

The "Contents" tab specifies which markets and asset classes (symbol types) you want to see in the trade 
ticker. You can also select to see only symbols from a watchlist.

The "Display" tab contains options for which columns to show and also configures behaviour such as 
smooth scrolling and color changes.

Element Description

Reverse direction Default direction is down for a vertical tickerline or from right-
to- left for horizontal tickerlines.

Smooth scrolling Will make the display of the ticker smoother.

Color changes Indicates whether each trade is to be displayed in colors if the 
price is up or down compared to the previous trading day.

The "Filter" tab can be used to remove irrelevant trades or to only show interesting ones. Options include 
minimum volume and value, broker codes and trade types.
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5.8.4 Available columns
Flags (country associated with the symbol's market)
Symbol (ticker code)
Description (instead of ticker code)
Price (last trade)
Hitter/Taker (the arrows indicates whether the last price is up or down compared to the previous 
trade)
Volume (trade volume)
B Id (Broker buyer ID. Only available for selected sources)
S ID (Broker seller ID. Only available for selected sources)
Bid (bid price at the time of the trade)
Ask (ask price at the time of the trade)
Time (time for the trade. Can be setup with seconds)
Trades outside bid/ask price range are marked with a diverging color.
Feed (datafeed on the trade)
Value (last value)
Change (last change)
Change % (change in percentage)
ESMA Type (trading type)

5.9 Basket trading

5.9.1 How to open
To open a new "Basket Trading" window, go to the main menu > "Tools" > "Basket Trading" under "Trading".

5.9.2 Requirements
Access to Trading
Access to Basket Trading

5.9.3 Description
The "Basket Trading" module allows you to define any number of orders locally that can be sent in one go, 
that is, as a basket of orders. There are several ways to define the orders, their types and acceptable price.

5.9.4 Creating, editing and deleting orders
The window has a simple toolbar at the top and a grid with columns and rows below. Use the "Edit" field and 
"Add" button to add new symbols to the basket - just as you would in the "Composite" window. Clicking 
"Add" without entering any value in the "Edit" field will allow you to perform a symbol search. To delete an 
order in the list, select it and click the "Delete" button (or press <SHIFT>+<DEL>).

Once you have one or more symbols in the basket, you can adjust the order's volume, open volume and 
price directly in the grid. Alternatively, you can use right-click, "Edit Order" (or press <CTRL>+<ENTER>) to 
edit the current order in a familiar dialog similar to the "New Order" dialogue window.

When you are satisfied with the orders, you can send them as one basket with the "Execute Basket" button 
in the toolbar.

A basket must be given a name so that you can recognize the live orders and trades it will 
generate.
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5.9.5 Saving and opening lists
Once you have defined a basket trading list, you can save it for later use. Click the "Save List" button in the 
toolbar, or use the right-click menu "List" > "Save List" and "List" > "Save List as..." commands.

5.9.6 Using price sources
We have made a concept of price source and price delta - as you can see in the "Source" and "Delta" 
columns, respectively. The "Source" column lets you select from a list of market values (last, bid, ask, mid, 
vwap). The current market value of that field is shown in the "MarketPrice" column and copied to the "Price" 
column. You can use the "Delta" column to adjust the price above or below the market price. As the market 
changes, the price will always be equal to MarketPrice + Delta.

To go back to setting manual prices, set "Source" to "Custom". This disables the "Delta" column and allows 
you to directly set the price.

5.9.7 Distributing a fixed amount
Sometimes you have a fixed amount of money that you want to use for buy or sell orders. If all the symbols 
in the basket list use the same trading currency, the program can help you distribute an amount on all the 
orders.

To make this easier, the amount, currency indicator and "Distribute" button on the toolbar are used. When 
distributing, the price you have configured for each symbol is used and a new volume is calculated. You can 
use the "Weight" column to set the relative weight (value) for the corresponding symbol.

Another factor that influences how the volumes are calculated is the "Volume rounding" setting in the 
"Distribute value" area on the Basket Trading page of the "Tools" > "Trading settings" dialog. The possible 
values are None, Down to Boardlot, Nearest Boardlot and Up to Boardlot. Depending on this setting the total 
value of the orders can be very close to, or slightly below or above the target amount.

Currently, the "Distribute" functionality is disabled if you have more than one trading currency in the orders 
list.

5.9.8 Importing and exporting
If you have defined a list of orders that should be executed in an external system such as Excel, the import 
and export functions available in the "Basket Trading" window come in handy.

A basket trading list can be imported via an external text file or via the Clipboard. In both cases, the data 
must be formatted in a simple tab-separated text format.

To import from the clipboard, use right-click "List" > "Import" from the Clipboard (or the shortcut 
<SHIFT>+<CTRL>+<V>).

To export to the Clipboard, use right-click "List" > "Export selected orders to Clipboard" (or the shortcut 
<SHIFT>+<CTRL>+<C>).

To import from a text file, use right-click "List" > "Import" from the file.

To export to a text file, use right-click "List" > "Export" to file.

The default value of the "Source" column is defined in the "Tools" > "Trading settings".
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5.9.9 Copy and paste
The Clipboard export and import commands make it easy to duplicate one or more orders inside a basket 
list. This can be useful if you want to duplicate and then make small changes (for instance change the 
portfolio name).

5.9.10 The "Include" field and disabled orders
Orders in your basket list might be greyed out. This happens when one or more of the following conditions 
are not met:

Symbol identified by the program
Price set (or the order type does not require a price)
Volume set
Portfolio set
"Included" column selected

The basket cannot be executed until all orders are valid. Orders that do not have the "Included" column 
selected will be ignored for distribution and execution.

5.9.11 Available columns
You can easily change the default settings by right-clicking the columns, select "Field Chooser" and use 
drag-and-drop on the columns you want.

Most of the columns are self-explanatory or are explained above. The Custom#1-Custom#6 fields are used 
for custom fields defined by the trading provider for that specific market. It is easiest to use the "Edit 
Order" (<CTRL>+<ENTER>) command to set these fields.

5.10 Algo trading

5.10.1 Description
Algorithmic Trading (also known as Strategy Trading) uses a dedicated third-party server to automatically 
execute certain rules and parameters.
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Technically, the algorithmic engine runs on a server for a third party vendor. The trading provider programs 
this server by defining a number of named "strategies". For each strategy, several input parameters are 
defined. The list of available strategies and their parameters is sent to the end user during the login. The 
user selects from the list of strategies, fills in the mandatory parameters and sends the order to the server. 
Then the algo server monitors conditions such as market prices, volumes, time and so on and enters or 
cancels orders to try and fulfill the purpose of the strategy.

5.10.2 Access requirements
Access to trading server with algo support
Access to algo trading feature

5.10.3 How to access
Select the "Strategy" page of the "Trading" window.

5.10.4 Technical information
A strategy and each strategy field has a name that is displayed in the "Strategy" page of the "New 
Order" window.
A strategy and each strategy field can have a server-configured description or explanation that is 
displayed as a hint when the mouse pointer hovers over the field.
A strategy can be marked as default - this will be the selected strategy in a new "New Order" window.
A strategy can be limited to be supported only for a specific broker (for servers that support 
"Client"/"Asset Manager"/"Broker" fields)
A strategy can be marked as available only for a specific set of markets.
A strategy field can be of the following field types:

Drop-down list
String
Double
Integer
Date
Time
Boolean
Price
Volume

A strategy field can be limited to be displayed only for a set of feeds.
A strategy field can have a default value.
A string field can be multiline.
A strategy field can have constraints such as minimum and maximum value, maximum length and be 
marked as mandatory.
If the value of a strategy field violates the field's constraints, the field label is displayed in red and the 
mouse hint will show the constraint limits.

5.11 Smart orders

5.11.1 Access requirements
Access to trading server with algo support
Access to "Smart Order Trading" feature
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5.11.2 How to access
Select the "Smart Order" page of the "New Order" window.
In the "Consolidated Orderbook" window, "Smart Order" is the default order type.

5.11.3 Description
Smart orders are orders that can be executed on one or more exchanges that all have the same company 
listed. This is can be useful in automatically dividing a large order on multiple trading venues and getting a 
better average price than would be possible if the order was executed only on a single exchange.

For instance, the Swedish Ericsson company is listed on several exchanges, including the Stockholm 
Stocks Exchange and on MTF (Multilateral Trading Facility) feeds such as Turquoise, Chi-X, Nasdaq OMX 
Europe and Burgundy. When you send a "Buy Smart Order" on Ericsson to a server that supports these 
markets, your order may trade on all of these exchanges.

A Smart Order is a special case of the more general concept of Algo Trading. The details of how your smart 
order is executed on the different exchanges is delegated to a separate third-party algo or smart order 
server.

Just as with algo trading, you can be presented with a list of named smart order algorithms and each order 
may take a number of input parameters.

The user selects from the list of "Smart strategies" orders, fills in the mandatory parameters and sends the 
order to the server. Then the server monitors conditions such as cross-market prices, volumes, time and so 
on and enters or cancels orders to try and fulfill the purpose of the strategy.
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6 Market data
Find detailed descriptions of the market data windows available in Infront Professional Terminal.

See also:

Bar Chart
Calendars
Chart
Chart Data
Correlation Matrix
Curve Chart
Company Overview
Focus window
Heat Grid
Index Overview
Instrument Overview
Macronomic Indicators
Market pages
Market window
Top Investors
Broker Statistics
Derivatives
Option Calculations
News (market data)
Noise reduction
Orderbook
Orderbook Visualizer
Portfolio Tracker
Return Histogram
Search Screener
Seasonality Matrix
Watchlist
Fund Overview

6.1 Bar Chart

6.1.1 Description
The bar chart displays one or more instruments side-by-side. By default, it will display the selected 
instruments net change in percent. It can be configured to chart a number of historic values in order to 
quickly compare the instruments' performance against each other.

6.1.2 How to access
Select a range of symbols in a "Market" window, "Composite" window or a "Market Page" and select "Charts 
& Visualizations" > "Bar Chart".
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6.2 Calendars
With the Infront Professional Terminal's live "Calendar Service", you will be alerted to global macro-
economic key figures and other events before they happen. In addition, you will immediately receive the 
data once it is released.

The calendar can also be set up to show company events such as corporate actions, earnings releases, 
dividends and general meeting, providing you a full overview of the upcoming events.

6.2.1 How to open calendars in multiple ways

Main menu
To find equity calendars:

Open the main menu > select "Calendar" under "Equities".

To find macro calendars:

Open the main menu > select the calendar of your choice under "Macro".

The "Calendar" function is also found under "Utilities" in the main menu. Open the main menu > "Tools" > 
under "Utilities" you will find "Calendar".

"Find anything" search function
Type "Calendar" or "Macro" in the "Find anything" search field.

There are macroeconomic calendars, country calendars and equity calendars.
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6.2.2 How to use calendars
The calendar gives you a global overview on corporate and macro events, both current and historical.

The events are presented in a grid sorted on date, type and time with content based on the current selected 
filter.

Depending on events you will be able to view the following category of events:

Announcements
Results & dividend
Corporate actions
New listings & IPOs
Economic indicators
Government auctions
Other macro events

Filter calendars
To filter the events displayed by the calendar grid, click "Filter". This opens filtering menu below the toolbar.

By using the filtering function, you can select the period for which the events will be displayed by choosing 
either the predefined date range or defining the range yourself.

You can easily change which regions the calendar should display events for and what category of events 
should be visible.

Calendar grids show upcoming events in white, and past events are grayed out 15 minutes after the event 
values are received.

If an event has estimates, the actuals will be colored green or red depending on whether the outcome is 
better or worse than expectations.

6.3 Chart

6.3.1 How to open
Intraday charts and historical charts can be opened in several ways:

Right-click a symbol in a market window, watchlist or a market page and select "Charts and 
visualizations" > "Intraday chart" or "Historical chart".
Search for "IntradayChart", "HistChart" or "Chart" in the "Find anything" search field.
Use the shortcuts <CTRL>+<I> to open intraday charts and <CTRL>+<H> to open historical charts.

6.3.2 Default chart
Element Description

Toolbar (1) Here you can find the cursor, chart templates, annotations, 
studies, compare studies, chart settings, resolution, time-period 
and chart type.

Price line (2) Visually indicates the current price level.

Hover data (3) When cursor is on, a data-table is displayed for the selected date.
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Element Description

Hover price (4) Shows the price level on the right axis.

Volume bars (5) Are displayed in the background as a visual indicator.

6.3.3 Toolbar

Cursor

Turn on and off the cursor by clicking the "Show cursor" icon.

Templates

Find your templates by clicking the "Templates" icon.

Chart templates can be used for several purposes such as:

Create a default charting layout
Create different technical analysis templates
Quickly change charting layout without manually removing or adding elements to the chart
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Create several color themes for different chart types

You can also restore factory default, save and load your templates. All your saved templates will be placed 
in your "ontrade\Setup" folder.

Settings

Change your chart settings by clicking the gear icon in the chart toolbar. From here, it's also possible to 
revert back to the old chart setup, used in Infront Professional Terminal in the 8.5 versions and earlier.

Among other things, allow you to:

Choose axis
Target currency
Chart type (Area, Candle Stick, Line and so on)
Line style
Extend the chart
Show chart data
Show events
Adjust for splits/dividend
Change back to the legacy toolbar / summary bar

Annotations

Add annotations to your chart. This can be lines, channels, circles, arrows or for example long/short 
positions.

To change the coordinates, right-click on the annotations to prompt the different options.

Add compare study

Compare studies to different instruments by choosing a study comparison. By adding an instrument, you 
can also change axis, currency or line style. The compare study can be also be indexed, see percentage 
change, benchmark compared and much more.

Hold <CTRL> on the keyboard to draw the annotations.
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Add study

Add studies to your charts such as Moving Averages, Bollinger Bonds, RSI, Standard Deviation and much 
more. You can also select Instrument/Line, axis, period and line style for the different studies. The chart 
also updates in the background before clicking "OK", making it easy to see how the changes are reflected in 
the chart.

Resolution, time period and chart type

In the options in the top left, you can change chart type, time period and resolution.

You do not have to press <CTRL> when using Line Snap. To use the Line Snap, make sure the 
cursor is turned on and mark a point on the chart to generate a starting point.
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Study definitions

Study Definition

Average True 
Range (ATR)

Measures volatility. High ATR often occur at market bottoms following a panic sell-off. 
Low ATR value is often found during extended sideways periods, such as those found at 
tops and after consolidation periods.

Chande 
Momentum 
Oscillator 
(CMO)

The indicator is created by calculating the difference between the sum of all recent 
gains and the sum of all recent losses and then dividing the result by the sum of all 
price movement over the period. This oscillator is similar to other momentum indicators 
such as the Relative Strength Index and the Stochastic Oscillator because it is range 
bounded (+100 and -100).

Commodity 
Channel 
Index (CCI)

Quantifies the relationship between the price, a moving average (MA) of the price, and 
normal deviations from that average. The index is scaled by a factor of 1/0.015 to 
provide more readable numbers. Therefore, it is essentially a MACD, normalizing the 
deviation. The CCI can be adjusted to the time frame of the market traded on by 
changing the averaging period.

Directional 
Movement 
DI+/DI- (DI)

Helps determine if a security is "trending". The DMI trading system involves comparing 
the 14-day DI+ ("Directional Indicator Up") and the 14-day DI- ("Directional Indicator 
Down"). This can be done either by plotting the two indicators on top of each other or by 
subtracting the DI+ from the DI-. Wilder, who developed the system, suggested buying 
when the DI+ rises above the DI- and selling when the DI+ falls below the DI-.
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Study Definition

Directional 
Movement 
ADX (ADX)

ADX is an averaged combination of DI+ and DI- which serves as an indicator of the 
trend strength. The ADX is as an oscillator fluctuating between 0 and 100. Low readings 
(below 20) indicate a weak trend and high readings (above 40) indicate a strong trend.

Directional 
Movement 
ADXR (ADXR)

Quantifies momentum change in the ADX. It is calculated by adding two values of ADX 
(the current value and a value n periods back), then dividing by two. This additional 
smoothing makes the ADXR slightly less responsive than ADX. The interpretation is the 
same as the ADX; the higher the value, the stronger the trend.

Directional 
Movement 
DX (DX)

Combines the two DI+ and DI- lines of the DI analyses into one line.

High/Low 
Oscillator 
(HLO)

A simple model that uses today and yesterday's price to determine an oversold/
overbought situation. If the HLO curve is above zero, it indicates an overbought 
situation. Similarly, if the HLO curve is below zero, it indicates an oversold situation.

Intraday 
Momentum 
Index (IMI)

The IMI is an oscillator which is constructed by averaging n day's worth of upward price 
changes (close is greater than open) to n day's worth of downward price changes (close 
is less than open). Sell signals are issued when the index crosses above the overbought 
level of 70% and buy signals are issued buy signals are issued when the index crosses 
below the oversold level of 30%.

Market 
Facilitation 
Index (FI)

Analyzes the amount that the price is changing for each unit of volume. It does not 
include any information concerning the direction of price changes. Instead, it is used to 
determine the efficiency with which the price is changing. The value of this indicator is 
the difference between the high and low prices divided by the volume. Therefore, its 
value tends to be very small.

Moving 
Average 
Convergence 
Divergence 
(MACD)

The MACD is calculated by subtracting a 26-day moving average of a security's price 
from a 12-day moving average if its price. A 9-day exponential moving average called 
"signal" or "trigger" line is plotted on the top of the MACD to show buy/sell 
opportunities. The result is an indicator that oscillates above and below zero. When 
MACD is above zero, it means that the 12-day MA is higher than the 26-day MA. This is 
bullish; since it shows that recent expectations (that is, the 12-day moving average) are 
more bullish than previous expectations (that is,  the 26-day MA). This implies bullish 
(upward) shift in supply/demand lines. When MACD falls below zero, this implies that 
the 12-day MA is below the 26-day MA, implying a bearish (downward) shift in supply/
demand lines.

Price 
Oscillator

Almost identical to the MACD except that it can use any two user-defined moving 
averages and can display the difference in either points or percentage (MACD displays 
only points).

QStick Provides a way to quantify the amount and size of black and white bars in a candlestick 
chart. Black candlesticks represent a period when the price closed lower than it opened. 
Likewise, the white candlesticks represent a period when the price closed higher than it 
opened.
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Study Definition

Rate of 
Change (RC)

Displays the difference between the current price and the price n time periods ago. The 
RC displays the wavelike motion in an oscillator format by measuring the amount that 
prices have changed over a given time period. As prices increase, the RC rises - as 
prices fall, the RC falls. The greater change in the price, the greater the change in RC.

Relative 
Momentum 
Index (RMI)

The RMI is a variation on the Relative Strength Index (RSI) that adds a momentum 
component. As an oscillator, the RMI exhibits the same strength and weakness of other 
overbought/oversold indicators. During strong trend markets, the RMI will remain at 
overbought or oversold levels for an extended period. During non-trending markets, the 
RMI tends to oscillate predictably between an overbought level of 70 to 90, and oversold 
level of 10 to 30

Relative 
Strength 
Index (RSI)

The RSI is a price following oscillator that ranges between 0 and 100. A method for 
analyzing RSI is to look for divergence in which the security is making a new high but 
the RSI is failing to surpass its previous high. This divergence is an indication of an 
impending reversal. When the RSI then turns down and falls below its most recent 
trough, it is a confirmation of the impending reversal.

Relative 
Volatility 
Index (RVI)

The RVI measures the direction of volatility. The calculation is identical to the Relative 
Strength Index (RSI) except that the RVI measures a 10-day standard deviation of high 
and low prices instead of measuring period-to-period price changes.

RVI rules of confirmation:

Only act on buy signals when RVI >50
Only act on sell signals when RVI <50
If a buy signal was ignored, enter long when RVI>60
If a sell signal was ignored, enter short when RVI<40
Close a long position if RVI falls below 40
Close a short position if RVI rises above 60

Standard 
Deviation 
(SD)

The SD is a statistical measure of volatility. It is typically used as a component of 
another indicator. High standard deviation values occur when the data item being 
analyzed is changing dramatically. Low standard deviation values occur when prices are 
stable.

Stochastic 
Oscillator 
(SO)

The SO displays overbought and oversold levels. The SO consists of two lines where 
one is a 3-day average of the other. It should only be used in situations without a 
dominating tend.

Volatility 
(VOL)

The VOL indicator compares the spread between a symbol's high and low prices. It 
assumes that market tops are generally accompanied by decreased volatility, and that 
the latter stages of a market bottom are generally accompanied by decreased volatility.

Williams %R 
(WR)

The WR measures overbought/oversold levels. Very similar to Stochastic Oscillator, 
except that Williams %R is plotted upside down and the Stochastic Oscillator has 
internal smoothing.

Williams 
Accumulatio
n/
Distribution 
(WAD)

"Accumulation" is used to describe a market controlled by buyers. A market controlled 
by sellers is defined by "distribution". Williams recommend trading on divergences:

Distribution of the security is indicated when it is making a new high and the Acc./
Distr. indicator is failing to make a new high - Sell.
Accumulation of the security is indicated when it is making a new low and the Acc./
Distr. indicator is failing to make a new low - Buy.
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6.4 Chart Data

6.4.1 How to access
Chart data can be opened from the "Chart" window by selecting the "⋮" menu > "Show Chart 
Data" (<SHIFT>+<F9>). A blue sideline called "Chart Data" will populate on the right hand side of the chart. 
Click the extension arrows on the sidebar to open the chart data.

The chart data includes all indicators displayed in the chart.

6.4.2 How to export chart data
Chart data can also be copied or directly saved as a text file. This can be done by right-clicking the data > 
"Copy" / "Save to file".
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6.5 Correlation Matrix

6.5.1 How to open
Select multiple instruments in a market window or a watchlist > right-click > "Charts & Visualizations" > 
"Correlation Matrix".

6.5.2 Description
The "Correlation Matrix" window displays the cross correlation among multiple instruments.

Element Description

Time Frame Time series length. You can select from the following options:

All

Last year to date (LYTD)

Year to date (YTD)

1 to 5 years

Matrix Displays the cross-correlation across instruments as in "Pearson 
Correlation Coefficient". The coefficient displayed in the Matrix 
corresponds to the entire sample given the time frame selected at 
the upper left of the window.

Coefficient Each coefficient in the matrix can be selected. A single click will 
display a rolling coefficient, while a double click will display a 
comparison chart for the selected time frame.

Rolling correlation When a coefficient is selected, that is, Rho(Instrument A, 
Instrument B), a chart with a rolling coefficient will appear in the 
lower panel. The user can modify the size of the rolling window 
changing the number of "Correlation window".



Infront Professional Terminal – Market data

04/25/2022 150 / 258

•

•

6.6 Curve Chart

6.6.1 Description
The yield line chart displays one or more instruments side-by-side in a single line chart. By default, it will 
display the selected instruments net change in percent. It can be configured to chart a number of historic 
values to quickly see the performance.

6.6.2 How to access
Go to the main menu > "Explore" > "Yield Curve" in the "Fixed Income" category and select a country 
from the list.
Right-click, for example, a benchmark bond in a "Watchlist" or a "Market Page" window and select 
"Charts & Visualizations" > "Curve Chart".
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6.7 Company Overview

6.7.1 How to open a Company Window
Type in a company in the "Find Anything" field > select the company > select "Company Overview".
Right-click in the "Instrument Overview" window > select "Instrument information" > select "Company 
Overview".
Use the <CTRL>+<O> shortcut on your keyboard.

6.7.2 What is a Company Overview
The "Company Overview" window displays a lot of content in a relatively small window, separated by tabs. 
The window display an introduction of the company in a brief summary, the company's key data, 
performance and events. Furthermore, it shows chart, estimates and company peers, which allows users to 
stay up-to-date. It is also possible to access Watchlist and Correlation Matrix via the "Company Overview" 
window.
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Overview
In the "Overview" window, you have several tabs available.

Analytics
Provides the "Analytics Overview".

Factsheet
This tabs gives a "Company Factsheet" in PDF format, which provides a full overview of the company. The 
content of the report is provided by Infront Analytics and its third-party content providers for user personal 
information only.

GPRV
The GPRV (Growth, Profitability, Risk and Value) chart compares the company with all of its competitors. 
The greener the outer-circle, the better the companies perform compared to their competitors. It is possible 
to choose between international peers, regional peers and domestic peers.
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Estimates
This tab shows the consensus estimates for the company. The source is Factset. The estimates available in 
this window are:

EPS % Dividend Yield
Net Sales
EBITDA & Margin
EBIT & Margin
Net Income & Net Margin
Net Debt & Net Debt/Equity
Book Value & ROE
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Financials
This tab displays the company's financial statement. It is possible to choose between 1-year interim 
statement or 5-year annual statement. It is also possible to change currency between local, USD or EUR.
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Short
This window displays the short positions of the company. Clicking the plus sign next to the company name 
displays several positions.
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Company's homepage

By clicking on this link, the user will be directed to the Company's homepage.

Listings
This tabs shows the company's listing, which funds are invested in the company and other listings. This 
data can be shown in local currency, primary, EUR or USD.
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6.8 Focus window

6.8.1 How to open a Focus window for a specific instrument
Right-click the instrument > select "Instrument information" > "Focus" window.
Select the instrument > press <CTRL>+<SHIFT>+<F>.

6.8.2 What is a Focus window
The "Focus" window gives the user a quick overview of one specific instrument. The symbol field can show 
either the symbol ticker or full symbol name of the instrument. The price field allows the user to select 
between last bid or ask, and below either change +/- change +/-% or both are displayed. At the bottom, the 
change indicator will display the current trend based on the price field. The right part of the window 
consists of a range panel, with values in both ends displaying today's high and low. An arrow indicates 
where the price is according to high/low, and the bar will be red on negative since open and blue on 
positive.

6.8.3 Setup
The "Focus" window can be customized by going to the "Settings" menu in the window > select "Setup".

Element Description

Symbol label Choose between showing the "symbol ticker" and full "symbol name".

Price field The focus window can show bid, ask or last prices. Some users 
choose to open two focus windows for the same symbol with one 
showing bid price and the other showing the ask price.

Change field Choose to see percentage change, absolute change in price or both in 
the symbol window.

Decimals It is possible to override the intelligent decimals settings by 
specifying exactly how many decimals the focus window should 
show for the current symbol.
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6.9 Heat Grid

6.9.1 Description
Heat grids allow for easier visualization and interpretation of column-based data.

6.9.2 How to access
Right-click any column header and select "Heat Grid".

This opens the "Heat Grid Setup" window. This window lets you select from the columns available in the 
previous window to paint heat grids on.
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The colouring of the columns will colour the highest value of a column with the brightest green and the 
lowest in deep red.
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6.10 Index Overview

6.10.1 How to open an Index Overview Window
Type in the index in "Find anything" field > select the relevant index > "Index Overview".
Right-click in the "Instrument Overview" window > select "Instrument Information" > "Index 
Overview".
Use the <CTRL>+<O> shortcut on your keyboard.

6.10.2 What is an "Index Overview" window
The "Index Overview" window displays a lot of content in a relatively small window, separated by tabs. The 
window gives a full overview of the specific index and allows users to stay up to date.

Element Description

Overview Displays summarized information regarding the index, key data 
and performance, index movers as well as intraday and historical 
chart. In addition, it contains the leaders and laggers of the index.

Derivatives Displays associated derivatives markets.

News Displays news for the companies in the selected index. Filter out 
news headlines and add alerts to get notified when certain 
headlines are published.

Index Constituents Display all of the companies in the index. Here you can easily 
customize the window by adding preferable columns.
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6.11 Instrument Overview

6.11.1 How to open an Instrument Overview window for a specific 
instrument

Right-click the instrument > select "Instrument information" > "Instrument Overview".
Select the instrument > press <CTRL>+<Q> on your keyboard.

6.11.2 What is an Instrument Overview window
The "Instrument Overview" window is one of the most frequently used windows in Infront Professional 
Terminal. There is a lot of content packed into a small amount of space, separated by tabs.

Elem
ent

Description

Overv
iew

The "Overview" tab contains summarized information regarding price movements, performance 
and symbol information.

Order
book

For more information, see Orderbook.
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Elem
ent

Description

Detail
s

Shows details regarding performance, trades information and fundamental information such as 
share cap (usually equal to market cap), segment, country and so on.

Event
s

Shows relevant company events such as upcoming events in the company calendar, last 
dividend and rights issues.

Estim
ates

Estimates provides actual results and consensus estimates from Factset. For Nordic markets, 
SME Direkt is also available.

News Shows news for the current symbol. Filter out news headlines and add alerts to get notified 
when certain headlines are published.

Trade
s

Shows price movements (usually trades) and information regarding the trades such as trading 
venue, buyer ID and seller ID.

You can also filter a trades list for specific volumes, prices, buyers, sellers, market codes and 
more.

For more information about order types, see Order types.

Histo
ry

Shows historical price movements and statistics. Select a range of dates by highlighting the 
relevant rows. The statistics will automatically calculate for the period selected. If no period is 
selected, then the statistics will be based on the entire history of the symbol.
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6.12 Macronomic Indicators
The Macroeconomics Indicators window bring completely new coverage to macroeconomics analytics and 
data discovery. You can cover a vast array of criteria, from consumer spending and GDP growth, to car 
manufacturing, weapon sales and unemployment. You can also easily track historical data as well as 
forecasted data for each and every global data point. With all this data in reach, you need a powerful tool to 
find and make sense of the information that is relevant to you. The Macroeconomics Indicator makes it 
easy to search, filter, sort and analyse data so that you can cut through the noise and identify investment 
opportunities quickly and easily.

6.12.1 How to open the Macroeconomic Indicators
Go to the main menu > "Explore" > under "Macro", you can access the "Macro Indicators".

6.12.2 How to use the Macroeconomic Indicators
With over 7000 macroeconomic indicators available, we've made it easier to find the data points you need 
using predefined drop-down menus available for region, individual country topics and indicators.
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Indicator Description

Region In the drop-down menu named "Region", which you will find in the upper 
left corner of the window, you can select countries for predefined regions 
such as World, TOP, EU, Scandinavia G7, OPEC and more.

Country Select and/or clear all or individual countries.

Topic Select one or several macroeconomic topics that you want to display.

You can select topics such as Business, Climate, Consumer, GDP and 
more.

Indicator This menu will allow for even more granular selection of specific 
indicators within a topic.

As you will see, the topics you choose in the "Topic" menu will affect the 
selection in the "Indicator" menu.

6.12.3 Create a Macro Overview
Each indicator comes with a detailed overview window where historical values are combined with 
forecasted values both in a chart and as a table.

To create a macro overview, use the "Macro Overview" button in the upper right corner of the window.

Alternatively, right-click a row with an indicator, and then select "Instrument Information" > "Macro 
Overview". Or press <CTRL>+<O> on your keyboard.

Looking at the "Macro Overview" window, the chart displays a green section and a yellow section. The green 
sections shows the actual data, while the yellow section shows the forecasted data (if available).

6.12.4 Create a Chart
You can also create a "Historical Chart" or a "Bar Chart".

To do so, use the "Historical Chart" or "Bar Chart" buttons in the upper right corner of the window.

Alternatively, right-click a row, select "Charts & Visualizations" > "Historical Chart" or "Bar Chart".

When you place the cursor over one of the bars in the Bar chart, you will see that the corresponding country 
is highlighted in the 
bottom section.

6.12.5 Create a Visual Comparison
You can create a visual comparison of the indicator you have chosen. 

To do so, use the "Compare" button in the upper right corner for a full comparison between countries 
available in that given indicator.
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6.12.6 Macro Grid
The tab called "Macro Grid" shows an overview of selected countries and their GDP, GDP growth rate, 
Interest rate, Inflation rate and Unemployment. Green indicates a high value, while red indicates a low value. 
Yellow indicates a mid-high value and orange indicates a mid-low value.

6.13 Market pages

6.13.1 Market Overview
Market Overviews are premade pages that provide useful information for those who want to be updated and 
gain an insight into the market. You can easily find relevant market data belonging to particular asset 
classes, sectors and regions.

How to open
Go to the main menu > "Tool" > "Market Overview" > select a market overview (such as Norway Overview 
Dashboard).

You can right-click any symbol on a market page to get a symbol menu.
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6.13.2 Market pages
Markets are default market pages that gives you full overview of the activity in the market.

The Market window is one of the main ways to see a list of streaming quotes in addition to "Watchlist" and 
"Market Overview". All information is updated continuously and changes in prices are highlighted. Some 
markets may have many thousands of symbols available. If this is the case, Infront Professional Terminal 
will not show the "All Quotes" tab and instead default to the "Chains" tab.

How to open
Use the main menu:  Select "Markets" under "Equities" > browse through the different regions or 
simply begin typing to filter the list.
Use the "Find anything" field: Type "Market" in the search field and press <ENTER> on the keyboard. 
Then type the name of a market you are looking for.
Keyboard shortcut: Use <CTRL>+<SHIFT>+<M>.
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6.14 Market window

6.14.1 How to open a Market Window
Go to the main menu > Select "Markets" under "Equities" > Type in the preferable market and press 
<ENTER>.
Type in the preferable market in the "Find anything" field and press <ENTER>.
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6.14.2 What is a Market window
The "Market" window is one of the main ways to see a list of streaming quotes in addition to Watchlist and 
Market Pages.

The "Market" window displays a number of tabs depending on which market you are looking at. It is 
possible to filter the window by adding several columns in order to display data.

Element Description

All Quotes All information is updated continuously and changes in prices are 
highlighted.

Some markets may have many thousands of symbols available. If this 
is the case, the terminal will not show "All Quotes" and instead default 
to the "Chains" tab.

Indices The "Indices" tab has the same features as the "All Quotes" tab but only 
displays indices for the selected market.

Chains The "Chains" tab offers a selection of market lists usually containing a 
specific segment, category or constituents belonging to the market.

List The "List" tab in a market window only displays the symbols you have 
added manually from the "All Quotes", "Indices" or "Chains" tab. To do 
this, right-click a symbol and selecting "Edit" > "Add to List".

By default, all symbols added to the "List" tab in market windows are 
automatically saved when the application closes.

6.14.3 How to use
Element Description

Symbol information To get more information about a symbol, right-click any row and 
choose an option from the right-click menu.

Keyboard search With the window selected, begin typing on your keyboard to search 
within the list. Once you press <ENTER> on your keyboard, the 
symbol will be displayed on the top of the "Market" window. 
See User interface  to configure what should happen when you 
search in this window.

Select Columns If you want to add, change or remove any of the data shown in a 
"Market" window, open the "Settings" menu > "Select Columns".

Sorting Columns Sort by turnover, last price or any other column by double-clicking 
the column headers. The list will automatically keep itself sorted.
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6.14.4 Highlighting and modifying symbol
Element Description

Custom Background color Change background color for a symbol by right-clicking > 
select "Edit" > then "Symbol Color".

To remove a custom background color, right-click the symbol 
and select "Edit" > then "Clear Symbol Color".

Custom Symbol Description Enter a customized description for a symbol by right-clicking > 
select "Edit" > "Custom Symbol Description". The custom 
description will also be used by other windows in the Infront 
Professional Terminal, such as charts.

To remove a custom description, right-click the symbol and select "Clear Custom Description".

Eleme
nt

Description

Ranki
ng

The "Ranking" tab displays today's winners, losers and highest turnover. Select whether the 
ranking should be based on "all quotes", "chains" or "list" by selecting the source.

Overvi
ew

"Overview" provides a visual view of the selected market, the main market index, percent of 
shares traded (calculated using market capitalization) and number of symbols up/down.

Custom headlines can be added by right-clicking on any instrument in the list > select "Edit" > "Add 
headlines".

Notice that in a list with headlines, sorting by clicking the column captions is disabled. You can 
move symbols up or down your list by selecting it, and using the "Up" and "Down" arrows in the 
interface.

To reduce potential confusion, all custom descriptions begin with an asterisk (*).
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6.15 Top Investors
The "Top Investors" window provides information about the largest stockholders on selected exchanges for 
a company. The "Top Investors" combines the number of stocks with the current market price and 
calculates the market value on each investors portfolio. It also calculates the share percentage each 
investor holds in the company, and presents this information in a diagram. In a case where one investor is 
among the largest shareholders in several companies listed on the Exchange, each market value is 
presented in a diagram with a percentage of the investor's total portfolio.

6.15.1 Availability and Requirements
Professional user on Oslo Stock Exchange (Top 50 Investors).

"Top Investors" are updated on Monday every week.

6.15.2 How to open Top Investors
Right-click an instrument on Oslo Stock Exchange > select "Instrument Information" > "Top 
Investors".
Select the stock you want to see "Top Investors" for and press <CTRL>+<SHIFT>+<T> on your 
keyboard.

6.15.3 Investor and Symbol
The "Top Investors" window includes two tabs, "Investor" and "Symbol".

The "Investor" tab shows the investors and which companies the investors are shareholders in.
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• The "Symbol" tab displays the largest share holders in the selected company.
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6.16 Broker Statistics
"Broker Statistics" provides information on which brokers are purchasing and selling in the market. It also 
gives detailed information about how many trades the different brokers are doing, what their buy volume, 
sell volume and net buy volume is and so on. "Broker Statistics" are only available on:

Stockholm Stock Exchange
Copenhagen Stock Exchange
Helsinki Stock Exchange
Bolsa de Madrid, Equities
Toronto Stock Exchange

6.16.1 How to open Broker Statistics
Open one of the markets that display "Broker Statistics" > right-click one of the companies listed on 
the corresponding stock exchange > select "Trades & Orders" > go to "Broker Statistics".
Select the company in the "Market" window > press <CTRL>+<SHIFT>+<B> on your keyboard.

6.16.2 How to use Broker Statistics

Realtime and historical data
The broker statistics module provides you both real time (intraday) and historical data. To change the time 
period, right-click and select "Interval". Historical data is available for up to three years.

Select criteria to drill down
Use the "Show" drop-down list to select a range of brokers you want to see visually, or select the 
checkboxes to the left of the broker codes.

Ranking Bar Chart
Click the "Ranking Bar Chart" icon to rank the brokers by preferable factor.
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Ranking Pie Chart
The "Ranking Pie Chart" provides a visual representation of all broker statistics data.

6.16.3 All Brokers / Single Symbol
You can select between the following views.
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All brokers
Statistics for one market where all information about each broker is accumulated. In the "Table" view, each 
broker is represented with a number of trades executed, turnover and more.

Available columns

S (checkbox for Timeline Selected)
Full name (the broker's name)
ID (the broker's ID)
Time (time of last trade/update)
#Buys (number of Buy Trades)
#Sells (number of Sells Trades)
#Int Trades (number of Internal Trades)
#Trades (total number of trades)
#Trades % (trades shown in percent of total trades)
NB Value (Net Buy Value)
IValue (Internal Value)
TValue (Turnover Value)
TValue% (Turnover Value in percent)

Single Symbol
Statistics for one symbol where all active brokers activity is accumulated. This view displays accumulated 
data on all brokers active for the selected symbol. This enables you to get fast access to the brokers that 
are the largest buyers, sellers, most active and so on.
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Available columns

S (checkbox for Timeline Selected)
Full name (the broker's name)
ID (the broker's ID)
Time (time of last trade/update)
#Buys (number of Buy Trades)
#Sells (number of Sells Trades)
#Int Trades (number Internal Trades)
#Trades (total number of Internal Trades)
#Trades % (trades shown in percent of total trades)
NB Value (Net Buy Value)
IValue (Internal Value)
TValue (Turnover Value)
TValue% (Turnover Value in percent)

6.17 Derivatives
The program includes a window for derivatives that structures and presents the data in a certain view.

6.17.1 How to open the Derivatives window
Go to the main menu > "Tools" > "Derivatives" in the "Markets" category.

6.17.2 Requirements
Orc Software Derivatives feeds (for example, Eurex, EuroNext Liffe, OMX)
Access to "Advanced Derivatives" functionality package

6.17.3 What is the Derivatives window
The "Derivatives" window consists of the following tabs:

Outrights
Strategies
Spread Matrix
Packs

Outrights
The "Outrights" tab shows all the options and the combo symbols for the selected underlying instrument. 
There is a list of default columns, but this is configurable by the user. The user can sort on any column and 
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right-click to get to the symbol commands for a single symbol, including "Overview", "Orderbook", "Chart", 
"Buy", "Sell" and so on.

Spread Matrix
The "Spread Matrix" is used to compare the futures and forwards of an underlying, and get information 
about any combination contracts that are made up of these futures or forwards. You can also trade from 
the "Spread Matrix". The prices and volumes of calendar spreads (the "roll") are set out in a graph. All 
futures and forwards are represented both with a column and a row. The futures/forwards are sorted 
according to their expiry date. Early expiry dates are found to the left along the x-axis and near the top 
along the y-axis. If there is a combination of two futures/forwards, then you can find the combination in the 
intersection of the contracts. Each cell in the "Spread Matrix" provides information about the bid (Bid), ask 
(Ask), and last (Last) price of the contract, the volumes on the bid (b#) and ask (a#) side, and the volume in 
the last trade (Last #). There are two types of spreads displayed in the "Spread Matrix", front month over 
and back month over.

Front month over

The leg with the later expiry date is bought and the leg with the earlier expiry date is sold.

Back month over

The leg with the later expiry date is sold and the leg with the earlier expiry date is bought.

Which spread type is shown is determined automatically by the "Spread Matrix" and cannot be changed by 
the user. You cannot display two different spread types at the same time.

Example

In the preceding screen shot, you can see that there are two combination contracts, the OMX3DC and the 
OMX CS K03-M03 contracts. When you buy an OMX3DC combination, you buy a OMX May Forward 
contract, and sell an OMX Apr Forward. Hence, this "Spread Matrix" only show front month over spreads.

Calculate implied values for combo derivatives
Mostly used in the new "Derivatives" window, we now dynamically calculate the implied values for 
combination symbols. Each combination symbol has a number of leg symbols and volumes associated 
with it. The program now calculates implied Bid, Ask, BidSize and AskSize from the streaming quotes of the 
legs. In addition, there are Best Bid/Ask/BidSize/AskSize columns that show the "best" of the actual combo 
instrument prices and the implied prices from the legs.

6.18 Option Calculations
The program has an integrated real time module for calculations of implied volatility and "Greeks" such as 
Vega, Theta, Gamma and Delta. The calculation methods are Black Scholes, Black Scholes 76 and 
Binominal method.

6.18.1 How to open Option Calculations
Go to the main menu > select "Options" under "Equities" > choose a market.

Put/Call tab
A drop-down menu appears on to the left. Choose an underlying instrument. This displays all options 
connected to the instrument. Calls is on the left side and Puts on the right. Forwards or futures are 
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displayed to the left. Every expiry change is marked with a different background color (can be changed in 
the "Settings" menu).

6.18.2 Filtering
You can filter which options are shown in a series by ticking off the checkbox on the top.

Element Description

Bid/Ask Include only lines with Bid or Ask (on the put or call side).

Last - include only lines with Last (on the put or call side).

Strike Keeps only 5 options above and below underlying last.

Underlying Select the underlying instrument by using the drop-down menu.

Expires You can also filter the options by expiry date. The generic expires (<First 
expiry>, <Second expiry>, ...) are useful when creating workspaces 
because they always refer to the first three upcoming expiry dates and 
do not need to be modified.

Filter Click this if you have a filter, then increasing activity will include further 
options.

The filter is not dynamic. If there is a Bid price on an option, this will not 
be visible until you click "Update Filter" (or turn the Bid/Ask filter on and 
off).

You can sort all columns.

To go back to ordinary "Expire/Strike" sort, select "Expire Month".

Layout You can choose between "Analysis", "Default" and "Trading".

Volatility It is possible to choose between "Implied", "Historical" and "Custom".

Calculating Theoretical Values
Select "Option Calculator Setup" or right-click an option or stock and select "Calculation Setup" > select the 
feed for the underlying symbols (for example, Oslo Stock Exchange) and set the risk-free rate for that 
market (for example, 4%). You can also set up volatility for the underlying symbol manually, or fill in the 
number of days you want and ask the server to calculate a historical volatility.

The columns you select are duplicated and shown on both sides, both for call and put. Some 
columns are removed because they take up too much space, and do not show any useful 
information (ISIN, Symbol, Description, Subtype). Some columns have equal values for both Call 
and Put; these are shown in the center (Shortsynth, Longsynth, Strike, Expire Years, Expire Month, 
Expire Date, Expire Days). Some columns will have the same order on both sides, as close to the 
middle as possible (Bid, Bid Impvol, Bid Yield, Bid Arrow, Bid Size, Ask, Ask Impvol, Ask Yield, Ask 
Arrow, Ask Size). All other columns are seen in reverse on both sides.
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Example

Click "Select All" > "Set Days" > enter "30", press <ENTER> > click "Calc Volatility". A 
request is sent to the server to calculate historic volatility over 30 days for all stocks 
on ”Oslo Stocks" (this may take a while to save the first time). You can also fill in 
future dividends for each stock.

The values in the "Quote" windows are now being calculated.

For more information, see Calculation Setup.

6.19 News (market data)

6.19.1 Mixed news window
Infront Professional Terminal includes a "News" window where you can select and display news from 
several sources and filter the news in different ways. The news sources available vary from country to 
country. For more information about sources, please contact your vendor. Each news source is 
continuously updated and can be presented in text, HTML or other standard formats.

To open the main "News" window, select the main menu > "Tools" > "News". This opens a list of countries 
with available sources. To select from the list of sources, click the "+" icon to open the list. Click the sources 
you want displayed, then click "OK". If you want to select all sources, click the country node.

News in HTML format can be displayed in a browser within the program or in an external browser (such as 
Google Chrome).

The top panel in the "News" window displays a drop-down list with selected sources. To select one source 
only, select the corresponding source in the list. To edit the list, click the "Edit News Services" button or 
right-click in the "News" window and select "Edit News Services". Click the sources you want displayed/
removed and click "OK".

The top panel in the news window displays a drop-down list with chosen sources. To select one source 
only, mark the source in the list. To edit the list, click the "Edit News Services" button or right-click in the 
"News" window and select "Edit News Services". Click the sources you want displayed/removed and click 
"OK".

6.19.2 Company specific News window
The company specific "News" window includes only news for a specific company.

A company specific news window can be opened in three different ways.

Search for "news" in the "Find anything" search field > press <ENTER> and type in the ticker or name 
of the symbol you would like to see. 

Right-click a symbol > "News & Research" > "News".
Select a symbol and press <CTRL>+<SHIFT>+<W>.
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6.19.3 Filter News
Filter news by typing directly in the search field. For example, you can search for "North America" and see 
the filter criteria on the right hand side is "Geographical Area". If you also add "oil" in the search field, you 
can see that this can be filtered as a "classification".

You can also filter news stories by clicking the funnel icon and select "edit filter". Set conditions to filter the 
stories so that only stories that satisfy the conditions you have set are included in the list.

Element Description

Text in headline Type a filter expression string that must appear as part of the 
news headline matches will appear in bold.

Symbol tickers Type a list of comma separated symbol ticker codes that the 
news item must be linked to.

Classifications Check one or more classifications that the news item must 
belong to.

Geographical areas Check one or more geographical areas the news item must be 
tagged with.

Click the "Advanced" button to see more options. The following four options can be controlled by using 
checkboxes:

Element Description

Full text news Include non-flash news (news with stories).

Flash news Include flash news (news with no story).

Web-stories Include web-based news (via URL).

Plain text stories Include integrated news (showing text inside a window).

Finally, you can filter by news source as well as specific Category, Industry, Country and Topic codes. Most 
of the time, it is easier just to use the Classifications and Geographical areas filters above.
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Filter expression strings
The text input lines in the filter and alerts dialogs accept filter expression strings. The supported rules are:

Type a word to match that word.
Two words separated with a space work as an AND filter (both words must occur).
Two words separated with a plus sign ("+") or a pipe sign ("|") work as an OR filter (either word must 
occur).
A word prefixed with a minus sign ("-") work as a NOT filter (the word must not occur).

Examples filter explanation:
"OIL"
Field must contain "OIL"

"OIL" "GAS"
Field must contains "OIL" AND "GAS"

"OIL "+" GAS"
Field must contain "OIL" OR "GAS"

"-OIL" "-GAS"
Field must NOT contain neither "OIL" nor "GAS"

6.19.4 Historical news
The "News" window lets you view news items from yesterday or any other day in the past. In addition to the 
news source drop-down menu, there is a date drop down where you select what date it should show news 
for. The default "Today" shows all today's news and update with new news items in real time.

The other options let you see yesterday's news or any other date in the last week. You can select a specific 
date in the past with the "Select date" option. Note that historical news is not available from all news 
services.

In the "News list" window, there are new available columns for Category, Country, Industry, Language and 
Topic. These columns are used in news feeds such as AFX and Dow Jones.

In addition, there is a new FeedSymbols column that shows the explicit feed and symbol reference of each 
news item. It is mostly useful when tracking down issues with the news to symbol links.

A headline in the news list that is longer than the width of the column now has an ellipsis (...) at the end of 
the line. If you hover the mouse over the text, a hint pops up with the complete headline.

When you read an integrated (not web-based) news article, the date and time of the news item will now be 
included with the name of the news vendor at the top of the "News story" window.

For some news feeds (such as Dow Jones and AFX), a (red) flash news item might have a body, and a 
normal (black) news item might only have a headline.
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6.19.5 Flash News
Flash news are colored red in the "Composite" window, the "Symbol" window and in the "My List" page of 
the "Market" window.

6.19.6 Select background color
Right-click a column to select a unique background color for each news source.

6.19.7 Edit columns
To edit columns displayed, right-click one of the existing columns and select "Select Columns".

6.19.8 Available news columns
Field Description

Category Native category codes (differs between news sources)

Classification Logical classification (same for all feeds with codes)

Country Native country codes (differs between news sources)

Date Date of news item publication

FeedSymbols Feed and Symbol ticker codes related to this news item

Geographical Area Logical Geographical Area (same for all feeds with codes)

Headline Headline text

Industry Native industry codes (differs between news sources)

Language Native language codes (differs between news sources)

Story Id Story Id

Story Number Story Number

Story source 3-4 letter short code for the news feed source

Story web address The URL of web news stories

Symbols Symbol ticker codes related to this news item
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Field Description

Time (and date) Time of news item publication (includes date if not today)

Topic Native topic codes (differs between news sources)

6.20 Noise reduction
Noise reduction technology analyzes market data in your workspace and informs about interesting price 
movements and events.

Noise reduction is a set of tools that gives you faster alerts when something happens in the markets. Large 
workspaces with hundreds of instruments updating every second becomes easier to monitor when the 
terminal tells you of extraordinary movements and events.

6.20.1 Signals widget
Displays the five most interesting instruments in your workspace. The widget scrolls through the 5 
instruments replacing them when a new instrument becomes more interesting. Click the widget to see all 5 
instruments and details as to whether price, news, volume or speed of price movement is causing the 
signal.

You can turn signals on/off by using the right-click menu.
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6.20.2 Signals chain widget
Add a "Chain" widget: From a "Market" window or a "Watchlist" window, go to the chain tab, click the "Create 
Signals Widget" button in the toolbar.

This creates a new "Signals " widget in the main toolbar of Infront Professional Terminal, displaying only the 
most interesting instruments from your chosen chain. 

6.20.3 How are interesting signals detected?
The criteria used for detecting signals are several types of calculations based around:

Intraday price movements
Volume increase
News activity

6.20.4 New columns
More advanced users will also find that there are new columns you can add to the "Market" window to 
monitor or sort your instrument list based on:

Volume/ADV (Volume as percentage of Average Daily Volume)
High/low (price hitting historical high/low)
Signal MA Cross (moving averages crossings today)
Signal Score (the higher the score, the stronger the motion signal

6.21 Orderbook
Orderbooks display public buy and sell orders and are available as MBO (Market by order) and MBL (Market 
by level). Infront offers access Level 1 data, Level 2 and full depth data depending on access and market, as 
well as consolidated orderbooks (combines orderbooks from the main listing exchange with multilateral 
trading facilities).
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Element Description

Market by Level (MBL) Orderbook In this kind of orderbook, all the public orders on a symbol 
from a specific exchange are accumulated into unique price 
levels. So if there are 35 orders at 52,30 SEK, there will be only 
one level in the orderbook with an accumulated volume of 
55,748.

Market by Order (MBO) Orderbook The Market by Order orderbook contains all details o single 
orders in the public orderbook. An MBO orderbook may 
contain a large number of orders with exactly the same price. 
So you get much more detailed information about each order 
in the market.

Trading If you place an order through a trading service using Infront, 
the orderbook will highlight the price level that matches the 
price of your active order (green below). The feature is on by 
default, but can be turned off in Settings.

Market By Level from MBO Orderbooks Sometimes the MBO orderbooks may contains just too much 
information to be useful or digestible, sorting by level will help 
you get the information you need.

Accumulated MBL orderbooks aggregate all the orders that have the same price into one level. The 
advantage is the detailed MBO information available. Each order will get a separate line in the orderbook 
viewable by clicking the "+" icon next to bid/ask.

6.21.1 How to open an orderbook
There are various ways to open an orderbook:

Select the company for which you want to display the orderbook > right-click the company > select 
"Trades & Orders" > select "Orderbook".
Select the company > press <CTRL>+<D> on your keyboard.
Open the Instrument Overview > select the orderbook.
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6.21.2 Summary lines
The orderbook contains two summary lines. These can be turned on/off by right-clicking in the orderbook:

Summary line 1: Symbol ticker / VWAP / Volume / Last / Net change / Net Change %
Summary line 2: Orders / Bid Size / Bid / Ask / Ask Size / Orders

6.21.3 Suspensions
If an instrument (normally a stock) is suspended, the orderbook will automatically be displayed with an "X" 
mark. It is also possible to define a color for a suspended quote under "Edit Colors" > "Background if Status 
Set".

6.21.4 Display of Auction Surplus volumes
Display imbalance volume in an opening or closing auction on the following exchanges; Xetra Frankfurt, 
Euronext Paris, Copenhagen, Helsinki, Stockholm, Oslo. For more information, see Trading settings.

6.22 Orderbook Visualizer

6.22.1 How to access
Right-click an instrument > "Charts & Visualization" > "Orderbook Visualizer".
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6.22.2 Interpretation
The Orderbook Visualizer (OB Visualizer) has an x-axis representing the aggregate volume (sum of volumes 
at each price level), and a y-axis representing the price. The chart displays what is the available liquidity at 
each price level of the order book. One can think about it as "who is willing to buy at $10, would also like to 
buy at $9; Who is willing to sell at $10, would also like to sell at $11". Because of this logic, we can see it as 
an aggregation of the volume in a stepped fashion, where each step represents the next price level (because 
they are more favourable to the trader sitting on the best bid and offer, we can aggregate them.)

The graphic display of the orderbook has two main objectives. One is to deliver an easy-to-learn chart that 
enables the user, in a matter of seconds, to understand the market sentiment for the security under analysis 
for a given day; the other, to infer changes on the expectations about its fundamental value and perceived 
risk, as well as capture intraday market microstructure imperfections that create price distortions.

For the identification of the market sentiment for the instrument, the scope of interest is high since the 
order book is more informative about the aggregate supply and trading interests than quoted volumes and 
prices. With the possibility to compare today's liquidity dynamics with respect to averages, the analysis will 
be enhanced, allowing the user to spot changes on the instrument's liquidity supply. Moreover, the range of 
prices at which the chart analysis is performed has also different usages. Let us consider the analysis of 
the time series. The time frame selection is obvious and it depends on the user's interest, and this will also 
define the price range under analysis. Working with a live feed of the orderbook, the range selection is less 
obvious and we then provide the user with range filters that will facilitate the reading of the chart and the 
inference of information. If the user analyses the orderbook with the full range, that is, from the minimum 
value of Bid and the maximum of Ask, then the use of the OB Visualizer is to read changes on the 
expectations regarding the fundamental price of the instrument. For example, one might notice that closer 
to earnings release dates the shape will tend to widen, that is, the bid and ask legs will spread out.

On the other hand, and shorter price rage is best for analysing intraday market microstructure 
imperfections and profit from its mean reverting dynamics. In addition, the shape of the orderbook reveals a 
lot of information regarding the fundamental characteristics of the firm: solid, larger, and liquid companies 



Infront Professional Terminal – Market data

04/25/2022 188 / 258

•
•
•

tend to have a distribution of order prices that converge in the current best bid and offer; on the other hand, 
small, less established companies tend to have limited volumes and a high price dispersion.

6.23 Portfolio Tracker
Portfolio Tracker is the ultimate tool for real-time portfolio oversight. The Portfolio Tracker allows you to 
view, track and interact with your portfolio and the market. Real-time alerts based on Infront Professional 
Terminal's Noise Reduction algorithm keep you up to date on portfolio performance. In addition to 
integrating with your Portfolio Management system, Portfolio Tracker can also import portfolios via Excel or 
CSV files. With multi-account management, you can easily search your client's portfolios and oversee 
intraday performance of multiple portfolios.

6.23.1 Open Portfolio Tracker
You can open the Portfolio Tracker in various ways:

Main menu > "Tools" > under "Utilities" find the "Portfolio Tracker".
Type "Portfolio Tracker" in the "Find anything" search and press <Enter>.
Main menu > "Tools" > under "Trading" find "Trading" > use your "Trading portal" > "Portfolio" > 
"Portfolio Tracker".

6.23.2 How to use the Portfolio Tracker
Click "+New" > create a name for the Portfolio > select currency.

To create a new portfolio without importing from Excel:
Click "+New" > create a name for the Portfolio > select currency > .

To compare your Portfolio to a benchmark, search for a Benchmark (for example, STOXX 600) > click 
"Create" to create your portfolio > to add instruments, click "Add" > add symbol.

To create a new portfolio via watchlist:
Create a list with instruments of choice > click "Actions" > "Convert to Portfolio" > create a name for the 
portfolio > select currency.

To compare your Portfolio to a benchmark, search for the benchmark > "Create".
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To create a new portfolio by importing from Excel
Click "+New" > create a name for the portfolio > select currency.

To compare your portfolio to a benchmark, search for "Benchmark" > "Load" > the information you import 
from Excel will be reflected in the Portfolio Tracker > select the columns the Portfolio Tracker should 
identify; that is, Symbol, ISIN, Quantity, Open price > import > create.
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6.23.3 Dashboard
Element Description

The Allocation chart Gives you a quick overview of your portfolio divided into 
various categories (for example, Financials, Banks, Airlines).

Geographical allocation chart Show you where in the world the companies are located. You 
can filter the map by clicking the drop-down menu named 
"Map".

Positive signals are shown in green, while negative signals 
are shown in red.

Contribution diagram Shows the positive/negative weight of your investment. You 
can filter the diagram by using the drop-down menu in the 
middle.

Winners and losers Displays today's winners and losers.

Signals and upcoming events Additionally, at the bottom of the window, you can see the 
latest signals and upcoming events for the stocks in your 
portfolio.

6.23.4 Holdings
Holdings gives an overview of your holdings. In the heading, you can see the value, which equals your total 
value of the portfolio; P&L %, which equals the development for your portfolio; the benchmark's 
development; and the difference between your portfolio and the benchmark.

Element Description

Edit To make any changes to your portfolio, click "Edit". Here, you can manually 
change quantity by typing directly in the column, change currency by 
clicking "Target Currency", save portfolio and easily choose between 
various portfolios by clicking on drop-down menu to the left of the toolbar.

Add alert Click "Actions" > "Add Portfolio alert"or "Add Symbol alert" for single 
symbols in your portfolio. These alerts can be edited and deleted in the 
"Manage Alert" window.

6.23.5 Characteristics
This tab shows the characteristics of your portfolio.

To change asset type, view, and edit how your portfolio is grouped, click on the tabs and select what you 
prefer.

The GPRV (growth, profitability, risk and value) chart compares the companies in your portfolio with all of 
their competitors. The GPRV scores measure the company's attractiveness, relative to its competitors in the 
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same sector. The bigger the green area, the better. To filter the GPRV chart, click the drop-down menu to the 
upper right of the chart and choose your preferable part of the world.

6.23.6 Backtest
Element Description

Return Histogram chart Shows the statistics of your portfolio (including Mean, Sigma, 
Skewness, Kurtosis, Observations). You can change the time 
frame of the chart by clicking "Period". It is also possible to 
change the step size by using the arrows up and down.

Backtest & Measures chart Shows the performance of your portfolio compared to the 
Benchmark index. Green shows a positive performance, while red 
shows a negative performance compared to the benchmark. You 
can filter the chart by a specific period, change the rate, change 
asset type and position.

6.23.7 Events
Shows all upcoming corporate events for the stocks in your portfolio, as well as the technical signals. 
These are the same technical signals that you can find on the Dashboard overview (first tab).

You can filter the events by right-clicking in the calendar. Here you can choose the time frame, as well as 
category.

6.23.8 Macro
Shows upcoming events for the countries you have invested in as well as a geographical allocation chart, 
which you can also find in the Dashboard. You can filter the map by clicking the drop-down menu named 
"Map". Positive signals are shown in green, while negative signals are shown in red.

You can filter the events by right-clicking in the calendar. Here you can choose the time frame as well as 
category.

6.23.9 Heatmap
The map helps you to follow real-time market movements visually. It is a graphical illustration of your 
portfolio. To filter the heatmap, use the settings menu on the left side of the widow, select "Heatmap 
Settings".

Here you can change "Size", "Grouping", "Size filter", "Color by", "Change filter" and "Color range" and select 
the layout you prefer.
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6.24 Return Histogram

6.24.1 How to access
Right-click an instrument > "Charts & Visualizations" > "Return Histogram".

6.24.2 How to use
This window displays the empirical distribution of the daily returns for a particular instrument or portfolio.

6.24.3 Period
Time series length. Options: "All", "LYTD" (last year to date), "YTD" (year to date), and 1 to 5 years. You can 
also specify a custom period by selecting "Custom".

6.24.4 Timeline
Allows the user to select the overview of the series in the lower panel. "Daily returns" displays the log 
returns in a bar chart, and "History" the actual values of the series.
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6.24.5 Statistics bar
On the top of the histogram, the moments of the empirical distribution are displayed.

Element Description

Mean Log daily returns.

Sigma Standard deviation from the log return series.

Skewness Standardized skewness of the empirical distribution as in Pearson's 
moment coefficient of skewness.

Kurtosis Excess kurtosis of the empirical distribution.

6.25 Search Screener
The "Search Screener" includes the "Bond Screener", the "Fund Screener" and the "Stock Screener". The tool 
can be used to find the specific instruments you are looking for based on a range of criteria in the entire 
universe of data.

To access the full functionality of the Search Screener, you will need the "Treasury" module for the "Fund 
Screener", the "Funds" module for the "Fund Screener" and the "Equity Analytics" module for the "Stock 
Screener".

You can open the "Search Screener" in multiple ways:
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Click the magnifying glass in the "Find anything" search field in the top left corner.
Use the "Find anything" search field > type "Screener" and press <ENTER>.
Click in the "Find Anything" field and press <ENTER>.

6.25.1 How to use the Search Screener

Search
The first tab is called "Search", where you can find different types of asset classes. From here, you can 
search for name, ticker or ISIN codes to find the instrument that you are looking for. The results will give you 
the ticker, description, feed and asset class.

Bond Screener
The "Bond Screener" contains several search fields allowing you to filter and narrow down your search 
results. The first search field is "Free text". If you enter "Glencore" in this search field, your results will show 
all instruments matching that description.

Furthermore, you can select the type of bond, industry, security, issue date, coupon type, issuer country, 
maturity, yield, coupon and minimum denomination.

You can also mark the bonds from your search result and click the "Create List" button. This will create a 
new watchlist with all the bonds that you have selected.

Fund Screener
The "Fund Screener" works in a similar way as the "Bond Screener". You can narrow down your search 
results based on a wide range of criteria. You can filter your result based on name, country, currency, 
category, regions invested, fund type, issuer, risk level, Morningstar rating, portfolio manager and more.

Stock Screener
The Stock Screener is an Infront Analytics tool and is therefore a bit different from the other screeners.  It is 
called "Market Screener" in the Infront Analytics tool.

Search categories
You can screen your results based on the three main categories:

Universe is based on location, marketplace and index.
Industry is based on Sector, including NAICS, Factset and SIC sectors.
Financial criteria is based on financial criteria as such as market cap, P/E, net sales and much more.

For example, you can add P/E and choose between 5 and 12. A list with all the Norwegian stocks with P/E 
value from 5 to 12 will then be shown in the screen results.
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6.26 Seasonality Matrix

6.26.1 How to access
Right-click an instrument > "Charts & Visualizations" > "Seasonality Matrix".

6.26.2 How to use
The Seasonality Matrix provides a graphical overview on the previous performance for specific months and 
years.

6.27 Watchlist
The "Watchlist" window is one of the main ways to see a lost of streaming quotes in addition to "Market" 
windows and "Market" pages.

The main difference that separates a watchlist from the others windows is that is is possible to add 
symbols from all markets you have access to.

6.27.1 How to open
Press <CTRL>+<SHIFT>+<C> on your keyboard.
Open the main menu > "Tools" > "Watchlist" under "Utilties".
Type "Watchlist" in the "Find Anything" search field.

6.27.2 Add instruments to watchlist
In the watchlist, type the name of the instrument in the blank field below "Chains" and "List" and 
select the instrument.
Click the "+ Add" button, and then type in the instrument you want to add.
Or drag instruments from multiple windows in Infront Professional Terminal. Open a "Market" 
window, select the relevant instruments, and drag them to the watchlist.
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You can also select another window such as the German Overview Dashboard and select the instrument 
you want to add to your watchlist and drag.

6.27.3 Save list
You can save the list by clicking the "Save List" button in the bar and then give the list a name. The lists are 
saved in a cloud, so they are available on your computer, phone or iPad.

6.27.4 Deleting symbols
Right-click and select "Edit" > "Delete" or just press <DEL> on your keyboard to delete a symbol from the 
watchlist.

6.27.5 Deleting entire lists
Once you have opened a saved list, right-click and select "Edit" > "Delete List" to delete it.

6.27.6 Adding custom headlines
Custom headlines can be added by right-clicking a symbol in the list > "Edit" > "Add headlines".

The text and background color of all headlines can be customized in the "Edit colors and fonts" window tool 
menu.

You can move symbols and headlines up or down your list by selecting it, then press <CTRL> while using 
the up and down arrows on your keyboard.

6.27.7 Group your holdings
You can group your holdings in your portfolio from the drop-down menu called "Group By".

6.27.8 Ranking
Rank today's winners, losers and symbols with highest turnover.

To do so, click "View" and then select "Winners and Losers" to turn this option on.
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6.27.9 News and Events
You will see news and events related to your instruments in the "News" and "Events" panel. You can 
customize the sources for your news by right-clicking in the panel and selecting "Sources".

You can adjust the time period of upcoming events by right-clicking in the "Events" panel and selecting the 
relevant period.

6.27.10 Portfolio Tracker using watchlist
You can convert your watchlist to a Portfolio Tracker. To do this, right-click in the watchlist, select "Edit" > 
"Convert To Portfolio". You can change the name of your portfolio, currency, add a benchmark and so on.

For more information, see Portfolio Tracker.

6.27.11 See Live Market Data in any currency
In your watchlist, you can choose to see your instruments market data in one of many currencies.

To do so, select your target currency from the "Convert ccy" drop-down menu.

6.27.12 Column Layout

Select columns
If you want to add, change or remove any of the data shown in a "Watchlist" window, click the content menu 
in the upper left of the watchlist > "Select Column" > select the columns you want to add.
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Sort Columns
Sort by turnover, last price or any other column by double-clicking the column headers. The list will 
automatically keep itself sorted.

6.27.13 Save Layout
After you have added the columns you want, this new column layout can be saved for later use.

Click on the content menu again > click "Save layout and filter as…" > enter a name for the layout.

To set this layout as the default layout for all new watchlists windows, right-click the content bar (column 
header), and then click "Save as default layout" and all watchlist windows you open after this will have this 
layout.

All custom layouts that you have saved in Infront Professional Terminal will also be available directly from a 
market window.

6.28 Fund Overview

6.28.1 What is a Fund Overview?
The "Fund Overview" window displays a lot of content into a relatively small window. Different tabs show 
important details about the fund itself. These tabs display amongst other things: a brief introduction of 
what kind of fund it is and its year of start, its Net Asset Value (NAV), statistics, and so forth allowing the 
viewer in question to access all important information in just one window.

6.28.2 How to Open a Fund Overview

Find anything
Insert the name of the fund you are looking for in the "Find Anything" search field > select the fund when it 
appears beneath the search field > scroll down and select "Fund Overview".

6.28.3 Watchlist
Right-click the fund in your watchlist > select "Instrument Information" > "Fund Overview".
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6.28.4 Result Overview

6.28.5 How to access the KIID and homepage
The KIID (Key Investor Information Document), is a mandatory document created by fund distributors to 
promote common supervisory approaches and practices in the application of the UCITS Directive and its 
implementing measures.

Click in the KIID link in the top right corner.
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6.28.6 How to access fund company's homepage
The homepage of the fund can be found displayed on the top right corner of the window. Simply click the 
link, and it will guide you directly to your web browser where the homepage will be accessed.

6.28.7 Morningstar Star Rating and statistics
This is a proprietary Morningstar data point.
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Mutual funds are rated 1 to 5 stars based on risk-adjusted rate of return. It takes into account the sales 
charges and compares similar funds in a category. The rating is based on 3, 5 and 10 years of performance 
history.

For more information about custom calculation of the statistic data, see Morningstar's documentation.

Data definitions can be found on Morningstar's Investing Glossary and Morningstar Rating & Risk.

6.28.8 Exposure tab

Top countries 
The table lists top 10 countries that the fund is invested in and their weights in descending order.
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Top sectors
The table lists sector exposure of the fund. In some cases however, the total might not add up to 100%. This 
is due to the fact that not all the funds report their holdings fully.

Style map equity
The Morningstar Style Box is a nine square grid that classifies funds by size along the vertical axis and by 
value and growth characteristics along the horizontal axis.

6.28.9 Details tab
The "Details" tab provides key information as well as the fund's investment objective.

Dividend distribution

Element Description

Accumulation Funds that reinvest dividends back to the fund.

Income Funds that pay out dividends. For income funds, the user can click 
"Income" and get an overview of all the previously paid out 
dividends.

Expenses

The total expenses of the fund.
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Other funds from this issuer

The table shows other funds that the issuer offers in the same currency as the current fund.

A user can open a "Fund Overview" for funds in the list by double-clicking on a fund.
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7 Excel
Learn all about the integration of the Infront Professional Terminal and Microsoft Excel.

See also:

RTD linking
Excel Add-in

7.1 RTD linking

See also:

Introduction to RTD links
Step-by-step RTD linking
RTD cell referencing
Why do my RTD links turn #N/A?
RTD linking for historical Data

7.1.1 Introduction to RTD links

What are RTD links?
RTD stands for Real Time Data. With RTD links, the data will update in real time and by default all the quotes 
are updated every two seconds.

Infront can display live, streaming data or historical data from the Infront Professional Terminal in Microsoft 
Excel.

Infront also has the option to use DDE (Dynamic Data Exchange) links. Both RTD and DDE links provide 
access to the same information. RTD, however, is a newer protocol that offers several advantages over DDE, 
including more flexibility and better performance and reliability.

What can I export to Excel?
The Infront Professional Terminal can display live, streaming data or historical data from the Infront 
Professional Terminal in Microsoft Excel. The rule of thumb is that if the column is available in the Infront 
Professional Terminal's market windows, custom lists or chains and there is data available, then you should 
be able to export this data to Excel. Both RTD (Real Time Data) and DDE (Dynamic Data Exchange) links 
provide access to the same information.

System requirements
RTD requires Excel 2002 or later. For older version of Excel, use DDE links instead.
The Infront Professional Terminal must be running in order for the RTD links to return any data; 
please make sure the Infront Professional Terminal is open and is completely logged in before 
opening any spreadsheets containing RTD links.

RTD formula
The RTD formula consists of the following elements:
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=RTD("ontrade.quotes","","feed code:symbol ticker", "", "field name")

It also supports an equivalent syntax, where the feed and symbol ticker are separate parameters:

=RTD("ontrade.quotes","","feed code", "symbol ticker", "field name")

The RTD formula explained

Element Description

ontrade.quotes Infront Professional Terminal's application name for the quotes 
module.

Feed code The cell which contains the market feed code.

Symbol ticker The cell which contains the ticker symbol.

Field name The cell that contains the name of the field data to display.

Example
In the below example, the formula is requesting the the last price for APPLE on the Nasdaq stock exchange 
(NSQ):

=RTD("ontrade.quotes","","NSQ:AAPL","","last")

Alternative syntax:

=RTD("ontrade.quotes","","NSQ","AAPL","last") 

7.1.2 Step-by-step RTD linking
Open a "Market" window/"Watchlist". Right-click on the column headings and choose "Select 
Columns". From the "Select Columns" window, you can add and delete column headings. These will 
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3.

be the fields you wish to export to Excel.

There are two ways to export to Excel using RTD links. The first step for both methods is to select the 
cells you want to be exported to Excel by holding down left click on the mouse and dragging the 
mouse across all of the data you want to export. 

 

When you have highlighted your selection, you can export the selection to Excel following the below 
directions:

Open as Excel sheet.
Click the Excel icon which appears to the top of the window. (The Excel Add-in needs to be installed 
for this button to appear.)
This will automatically open an Excel sheet with your selection. Alternatively, use the keyboard 
shortcut <CTRL>+<SHIFT>+<E> when you make the selection.
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If you click on one of the cells, you can see the RTD function used to get the data in the formula bar.
As you can see from the below, the formula uses cell referencing and is therefore dynamic and more 
flexible.

 
=RTD("ontrade.quotes","",$C6,"",E$5)

Element Description

ontrade.quotes Infront Professional Terminal's application name for the 
quotes module.

C6 The cell which contains the market feed code and ticker 
symbol.

E5 The cell that contains the name of the field data to display.
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4. Alternatively, you can copy the RTD link.
Right-click the selection and select "Edit" > "Copy RTD Link". Alternatively use the keyboard shortcut 
<Ctrl>+<R>. Paste into Excel and the highlighted selection will populate the Excel worksheet.

If you click one of the cells, you can see the RTD function used to get the data in the formula bar.

Differing from the cell referencing method used in the 3.1 example, this method is hard coded and 
references specific feed codes and ticker symbols in the formula.
=RTD("ontrade.quotes","","LSE:AAL","","last")

Element Description

ontrade.quotes Infront Professional Terminal's application name for the quotes 
module.

"LSE:AAL"  The market feed code and the ticker symbol.

"last" The name of the field data to display.
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7.1.3 RTD cell referencing
One benefit of RTD links is that it is like any other function in Excel. This means that RTD links support 
referencing to other cells (as can be seen in the section "Step-by-step RTD linking").

RTD formula elements:
An RTD formula consists of the following elements:

=RTD("ontrade.quotes","",feed code,symbol ticker,field name)

Element Code

ontrade.quotes Infront Professional Terminal's name for the quotes module.

feed code The cell which contains the market feed code.

symbol ticker The cell which contains the ticker symbol.

field name The cell that contains the name of the field data to display.

With the following formula (cell B13) to get the Last price for an instrument:

Element Description

ontrade.quotes Cell B6

feed code Cell B9 (LSE)

symbol ticker Cell C9 (AAL)

field name Cell D9 (last)
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7.1.4 Why do my RTD links turn #N/A?
#N/A means "Not Available" and this could be caused by different reasons.

This is a common Excel error that is not related to Infront Professional Terminal, but a known problem that 
can occur in Microsoft Excel. We highly recommend you to run Infront Professional Terminal before you 
open any Excel spreadsheets containing RTD links. This is necessary for the RTD links to work.

#N/A might appear if some files are not placed correctly according to the installation. Therefore, repairing 
Excel from the "Control Panel" could solve the issue. This can be done by following the instructions below:

Click the Windows "Start" button and open the "Control Panel."
Click the "Uninstall a program" link under "Programs".
Scroll down and select "Microsoft Office".
Click the "Change" button and wait for a new window to open.
Click to select the "Repair" option and click "Continue" to authorize your computer to repair Microsoft 
Excel to its default settings.
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Other troubleshooting options
The issue can also be related to the add-in options in Excel. You can also try the following:

Go to file > Options > Add-ins.
Make sure that "ontrade.quotes" is shown as active. Make sure that the add-in is not placed under 
"Inactive Application Add-ins". If it is inactive, try to activate it again.

Make sure that you are running the latest version of Windows and that all updates are installed.

7.1.5 RTD linking for historical Data
Export dynamic historical data from Infront Professional Terminal using RTD to Excel. This means that each 
date is dynamically updated every day.

Historical RTD Formula
A historical RTD formula consists of the following elements:

=RTD("ontrade.hist","",feed code,symbol ticker,"prices",row number,field name)

Element Description

ontrade.hist The module in Infront Professional Terminal where data is 
requested.

feed code The cell which contains the market feed code.

symbol ticker The cell which contains the ticker symbol.

prices Specifies pricing data.
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Element Description

row number The date for the most recent day available will be 0. If the row is 1, 
this will always be yesterday, row 2 will be 2 days ago and so on.

field name The cell that contains the name of the field data to display.

Step-by-Step Historical Data Export using RTD
Open a symbol overview.
Switch to the "History" tab.
Highlight the selection of data you want to export by holding down the left mouse button and 
dragging across your data selection.
Right-click > "Edit" > "Copy RTD Link" (or press <CTRL>+<R> on your keyboard).
Paste into Excel.
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In the example below, the formula is requesting the open price for BARC on feed LSE (London Stock 
Exchange) for the row 0 (the most recent date available):

=RTD("ontrade.hist","","LSE","BARC","Prices","0","open") 

Static Historical Data by Date
Export static historical prices. This means that the data will not dynamically update every day, but rather be 
static and reference data on specific dates instead.

A historical RTD formula consists of the following elements:

=RTD("ontrade.hist","",feed code,symbol ticker,PricesByDate,date,field name,CW/ C/ "")
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Element Description

ontrade.hist The module in Infront Professional Terminal where data is 
requested.

feed code The cell which contains the market feed code.

symbol ticker The cell which contains the ticker symbol.

PricesByDate Reference to a specific date in the formula.

date The date for which you want to view the data.

field name The cell that contains the name of the field data to display.

CW Copy data for weekdays only, do not copy weekends.

C Copy data for all days (including weekends).

"" Copy data for all days excluding national holidays.

For example, in the example below, the formula is requesting the open price for BMW on feed XET (Frankfurt 
Xetra, Equities) for 20/04/2022:

=RTD("ontrade.hist","","XET","BMW","PricesByDate","2022-2-22","open","CW")

7.2 Excel Add-in

See also:

Download and system requirements
User login
Quick report
Time series

7.2.1 Download and system requirements

Download the Infront Excel Add-in
Infront Professional Terminal comes with an advanced equity and sector Analytics platform. Install 
the Excel Add-in to use the full depth of equity fundamental information available in Excel.

To download and install the Excel add-in, type "Excel" into the <CTRL>+<F> search bar and select "Install 
Excel Add-in". This will direct you to the Infront website and a set of instructions for installing the add-in.
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System requirements
Operating system: Windows 7/8/10
Processor: 2 GHz Intel or more
Internal memory (RAM): 4 GB or more
Screen resolution: 1024x768 resolution (1920x1080 or higher will offer the best experience)
Monitors: The program can run on one or multiple monitors
Hard disk: approx. 100 MB required for the program
Internet connection: 2 Mbit/s or higher (depending on data volumes)
Microsoft Excel: 2010/2013/2016/2019/365 - 32 or 64bit
.NET Framework : 4.7 (it will be automatically installed if needed)

Connections through Firewalls and Antivirus Software

Firewalls

Check the local firewall settings. Some personal firewalls are poorly designed and might unintentionally 
limit Internet usage more efficiently than the user intends.

You have to authorize Infront Analytics IP addresses and domain names on your firewall.

Antivirus Software
Antivirus software installed on a user's computer can sometimes block an application from running, and 
sometimes it does not inform the user about it.

Many antivirus programs offer a way around this in their settings.

Loading the add-in in Excel
You do not need to load the add-in manually in Excel if automatic loading is activated.

If you prefer to load the add-in only when you need it:

Start Excel.
Type "Infront" in the Windows "Start" menu and select the application Excel Add-in.

Alternatively, you can open the Windows "Start" menu and search for the add-in in the folder "Infront 
Analytics".

The Infront Professional Terminal must be running for the Infront Excel Add-in to to return any 
data.
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7.2.2 User login

User login
The login tab on the "Settings" window has two sections: one for Infront Analytics credentials and one for 
Infront Professional Terminal:

Infront Analytics

This connection is mandatory to be able to use the Excel Add-in and by default, your are connected with 
your Infront Analytics credentials. Once logged in, you cannot modify the connection credentials.

This connection provides you access to the Infront Analytics data universe (companies, lists, fundamentals, 
estimates…).
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Infront Professional Terminal

In addition to the mandatory default Infront Analytics connection, if your are using the Excel Add-in 
from Infront Professional Terminal, then you need to connect with your Infront credentials that give you also 
access to the Infront data universe (Instruments quotes, trading data…).

7.2.3 Quick report
Quick report is the functionality that allows you to import field-based data from the Infront Analytics 
platform into Excel. In addition to retrieving the data, it creates a connection from your workbook to the 
platform that makes it easy to refresh the data when needed.

Quick report format
The default format for a Quick report on multiple companies is companies in rows and data items in 
columns.
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However, when creating a new Quick Report, you have the option to transpose your data in order to have 
companies in columns and data items in rows.

As you can see below, the currency is set by default to "Reference" (reporting currency), which is the 
currency used by the company when reporting its financial statements:

Quick report editing and updating
Once created, a Quick Report can be edited (use the "Edit" button) to perform changes on the company 
universe, the selected data items, or any other options except the format.

A Quick Report is a database snapshot that can become stale (out of date) when the data on the platform 
changes. At any time, you can trigger a refresh action by using the "Refresh" button to update your data.

7.2.4 Time series
Time series is the functionality that allows you to import historical data for a list of instruments into Excel. 
In addition to retrieving the data, it creates a connection from your workbook to the platform that makes it 
easy to refresh the data when needed.

Instrument types
Available instrument types include:

Companies
Market indices
Industry sector indices
Currencies
Bonds*
Funds*
Futures*
Options*
Stocks*
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Data types
Available data types include:

Quotes Daily
Market capitalization
Dividends
Estimates FactSet
Target Price
Quotes Intraday*

Time series format
By default, the time series format is a vertical descending table (most recent date at the top).

You can switch to ascending format by editing your time series.

As you can see below, the currency can be set to "Reference" (reporting currency) which is the currency 
used by the company when reporting its financial statements: 

Time series editing and updating
You can edit a time series by using the "Edit" button. Instruments, time period and formatting options can 
be modified. However, the data type cannot be modified in an existing time series.



Infront Professional Terminal – Excel

04/25/2022 221 / 258

A time series is a database snapshot that can become stale (out of date) when the data on the platform 
changes. At any time, you can trigger a refresh action by using the "Refresh" button to update your data.

*only available for Infront Professional Terminal users
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8 API
Learn how to use Infront’s Destop API for R and Python to perform portfolio analyses, simulate extreme 
events, create visualizations and indicators.

See also:

End-of-Day API
Python API
R API

8.1 End-of-Day API
The EOD Desktop API provides you with End-of-Day or Historical data and can be accessed directly from a 
3rd party console.

The Infront End-of-Day service can be used by 3rd party server systems to request end-of-day prices from 
Infront for a specific set of instruments.

The server system first posts a request for data and then polls the Infront service for the response until it is 
ready.

To access the EOD Desktop API, you need access to the Infront Professional Terminal, the EOD module and 
the market data for the API request. The data returns formatted as JSON or XML. The Infront End-of-Day 
Web API documentation can be found here:

https://eod.infrontservices.com/#documentation

Instruments are identified by using "Operating MIC", "ISIN" and (optional) "currency". Alternatively, 
instruments can be identified by using the Infront "feed number" and "ticker code". Be aware that 
instruments that are not found by Infront or that have multiple possible matches (ambiguous) will be 
marked in the result with an error code. The API is also case sensitive. For example, spelling 
"operating_mic" as "Operating_MIC" will not work.

The End-of-Day service is HTTP/REST based and uses JSON as data protocol.

The server accepts four types of requests:

Request type Description

End-of-Day Service used to make a request for one or multiple 
instruments.

Historical Service used to make a request for one or multiple 
instruments.

Instrument Search Service used to get information about an instrument.

Accessible Markets Service used to get information about accessible markets for 
a given user.

The following data can be retrieved with EOD API:
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Data type Description

EOD Name, Previous close date, Previous close, Volume, Turnover, 
Bid, Ask, Currency.

Historical Last, Volume, Turnover, Bid, Ask, Open, High, Low.

Instrument Search Operating mic, ISIN, Feed, Instrument type, Feed name, Ticker, 
Name, Currency.

Accessible Markets Operating mic, Feed, Feed code, Feed description.

The EOD Desktop API provides you with End-of-Day or Historical data and can be accessed directly from a 
3rd party console.

The Infront End-of-Day service can be used by 3rd party server systems to request end-of-day prices from 
Infront for a specific set of instruments.

The server system first posts a request for data and then polls the Infront service for the response until it is 
ready.

To access the EOD Desktop API, you need access to the Infront Professional Terminal, the EOD module and 
the market data for the API request. The data returns formatted as JSON or XML. The Infront End-of-Day 
Web API documentation can be found here:

eod.infrontservices.com/#documentation+

Instruments are identified by using "Operating MIC", "ISIN" and (optional) "currency". Alternatively, 
instruments can be identified by using the Infront "feed number" and "ticker code". Be aware that 
instruments that are not found by Infront or that have multiple possible matches (ambiguous) will be 
marked in the result with an error code. The API is also case sensitive. For example, spelling 
"operating_mic" as "Operating_MIC" will not work.

The End-of-Day service is HTTP/REST based and uses JSON as data protocol.

The server accepts four types of requests:

Request type Description

End-of-Day Service used to make a request for one or multiple 
instruments.

Historical Service used to make a request for one or multiple 
instruments.

Instrument Search Service used to get information about an instrument.

Accessible Markets Service used to get information about accessible markets for 
a given user.

The following data can be retrieved with EOD API:
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Data type Description

EOD Name, Previous close date, Previous close, Volume, Turnover, 
Bid, Ask, Currency.

Historical Last, Volume, Turnover, Bid, Ask, Open, High, Low.

Instrument Search Operating mic, ISIN, Feed, Instrument type, Feed name, Ticker, 
Name, Currency.

Accessible Markets Operating mic, Feed, Feed code, Feed description.

8.2 Python API
The Infront Python API is an easy way to analyse data with your own Python scripts. It provides finished 
wrapped data in data frames, and you can use it with a Command Line Interface (CLI). Using Infront’s 
Python API, you can conduct portfolio analyses, simulate extreme events and their effect on prices, and 
create visualizations and indicators to better understand the market dynamics and much more. Python, as 
your daily companion with your Infront Professional Terminal, provides you with over 114,000 open-source 
packages covering thousands of use cases.

To access the full functionality of the Python API, you will need:

Infront Professional Terminal
EOD Module
Access to relevant market data

8.2.1 How to open the Python API
First, you need to install Python. 

You can find the installation for Python here. Click "Download Python" and install Python on your 
computer.
A new window will pop up, click "Customize installation".
The next window will show optional features.  
We recommend you to install all features. Select:

Documentation
pip
tcl/tk and DLE
Python test suite
py launcher and for all users

Click "Next" which will forward you to a window with overview of "Advanced Options". 
Select "Associate files with Python."
Create shortcuts for installed applications.
Add Python to environment variables.

If you do not have access, please contact Infront.

Following the external link below opens a new browser tab and sends you to a website outside of 
the Help Center.
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Click "Install" and the installation will start.

Once you have installed Python, you can follow the instructions under the Infront Connect Installation. You 
can find this on our website.

8.2.2 How to use the Python API

Finding a symbol
The Feed and Ticker fields are required to find a match for an instrument. These can be found in the 
"Overview" window for the instrument in the Infront Professional Terminal. It is also possible to find this 
information in a watchlist. To do so, open a watchlist, add the preferable instrument and add the columns 
Ticker and Feed.

An example, Feed = "OSS" and Ticker = "DNB". In Python code it will look like this: ["OSS:DNB"]

To send an API request: You can use the documentation to send an API request here.

There are a few variables you can change:

Tickers: You should change FEED and TICKER to the feed and ticker that you want to export history 
from. If you want to export data DNB from Oslo Stock Exchange you put in OSS instead of FEED and 
DNB instead of TICKER, for example ["OSS:DNB"]
Fields: The fields that are supported in the Python API are

open
high
low
last (last value from the day before)
turnover
volume
bid
ask
Start date: Here you can set the date from when you would like to get the historical data. The 
date format is "YYYY-MM-DD", for example "2019-01-01".
End date: This date has the same format as Start_Date and you can set the last date in the 
period you want to export history from. If you set this to a future date, for example 
"2099-01-01", you will get all the data from the start date until yesterday’s date.

Example of an API request without information inserted

MySymbol = infront.GetHistory(tickers = ["FEED:TICKER"], fields = ["open", "high", 
"low", "last", "turnover", "volume", "bid", "ask"], start_date = "YYYY-MM-DD", end_date 
= "YYYY-MM-DD")

Example of an API request with information inserted

(Ticker= DNB, Feed= OSS. Start_date= 2019-01-01, End_date= 2099-01-01: MySymbol = 
infront.GetHistory(tickers = ["OSS:DNB"], fields = ["open", "high", "low", "last", "turnover", "volume", "bid", 
"ask"], start_date = "2019-01-01", end_date = "2099-01-31")

The data that can be retrieved with Python API includes:

Following the external link below opens a new browser tab and sends you to a website outside of 
the Help Center.
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Historical Data
Stocks, bonds, futures, forex, warrants
Fields: open, high, low, last, turnover, volume, bid, ask

8.3 R API
The Infront R API makes it efficient to analyse data with the built in tools that R supports. You can easily 
create your own graphical charts like return histograms by using R's graphical user interface (GUI). Using 
Infront's Desktop API for R, you can conduct portfolio analyses, simulate extreme events and their effect on 
prices, create visualizations and indicators to better understand the market dynamics, and much more.

As your daily companion with your Infront Professional Terminal, R provides you with over 6,500 open-
source packages covering thousands of use cases. 

To access the full functionality of the Python API, you will need:

Infront Professional Terminal
EOD module
Access to relevant market data

8.3.1 How to open the R API
You can use various types of software to access the R API. An example of software you can use is RStudio. 
Once you have decided on your software of choice you can follow the installation instructions here.

8.3.2 How to use the R API
To find a symbol: There are a few fields that are required to find a match for an instrument. That is, Feed 
and Ticker. This can be found in the

Overview window for the instrument in the Infront Professional Terminal. It is also possible to find this 
information in a Watchlist.

To do so, open up a Watchlist, add the preferable instrument and add the columns Ticker and Feed to your 
Watchlist.

Example

Feed = "OSS" and Ticker = "DNB".  In RStudio it will look like this:

["OSS:DNB"]

To get multiple symbols in the same request you can use a comma as a separator. Example:

["OSS:DNB", "SSE:VOLV A", "..."]

You can use the documentation to send an API request here. There are a few variables you can change. 
These are:

If you do not have access, please contact Infront.
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Variable Description

Tickers You should change FEED and TICKER to the feed and ticker you want to 
export history from. If you want to export data for DNB from Oslo Stock 
Exchange, you use OSS instead of FEED and DNB instead of TICKER, 
that is, c("OSS:DNB").

Fields

The fields that are supported in the R API include:

open

high

low

last (last value from the day before)

turnover

volume

bid

ask

Start date Here you can set the date from when you would like to get the historical 
data. The date format is "YYYY-MM-DD", for example "2019-01-01".

End date This date has the same format as Start_Date and you can set the last 
date in the period you want to export history from. If you set this to a 
future date, for instance "2099-01-01" you will get all the data from the 
start date until yesterday’s date.

Example of an API request without information inserted

MySymbols = GetHistory(tickers = c("FEED:TICKER), fields = c("bid","ask","turnover","volume","last"),

start_date = "YYYY-MM-DD", end_date = "YYYY-MM-YY")

Example of an API request with information inserted (Ticker= DNB, Feed= OSS

Start_date= 2019-01-01, End_date= 2099-01-01):

MySymbols = GetHistory(tickers = c("OSS:DNB"), fields = c("bid","ask","turnover","volume","last"),

start_date = "2019-01-01", end_date = "2099-01-01")

The data that can be retrieved with R API includes:

Historical Data
Stock, bonds, futures, forex, warrants
Fields: open, high, low, last, turnover, volume, bid, ask
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9 Treasury
Find out more about the Infront Professional Terminal Treasury module.

See also:

Interest rate swaps
Forward rate agreement
Overnight Index Swaps
Bond Matrix
Interpolation Tool

9.1 Interest rate swaps

9.1.1 How to open
Search for "Interest Rate Swaps" by using the search field > select a given base currency from the 
list.
Main menu > "Explore" > "Money Market" > "IR Swaps".



Infront Professional Terminal – Treasury

04/25/2022 229 / 258

Function Description

Base Currency selection. When more than one currency is selected, then 
the currencies will appear below the toolbar as tabs. The Infront 
Professional Terminal will remember your selection for convenience 
when the window is saved in a workspace.
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Function Description

Basis Select the type of swap: Interest Rate Swap, Currency Basis Swap, 
Tenor Basis Swap.

Contributor Select the sources of the information to be displayed. It can be 
global and regional banks, or inter-dealer broker data.

Columns Allows the tailoring of the data to be displayed, such as mid yield 
and symbol name.

Consolidation When selected, it displays a single set of quotes that correspond to 
the last updates.

Excel RTD Linking Select the series or instrument to export to Excel and press 
<CTRL>+<R>.

Swap Curves Double-click any series to chart them.To compare them, click any 
instrument while holding <CTRL> to drag and drop into an existing 
chart. Other instruments are supported.

9.1.2 Useful keyboard shortcuts
Keyboard shortcut Description

<F11> Hides toolbar.

<CTRL>+<C> Consolidates the contributed data on a time of update basis.

<CTRL>+<RIGHT> Expands all collapsed groups.

<CTRL>+<LEFT> Collapses all groups.

9.2 Forward rate agreement

9.2.1 How to open
Search for "FRA" in the search field and click the first result in purple > choose a given currency from 
the list.
Main menu > "Explore" > "Money Market" > "FRAs" > select a currency from the list.
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Function Description

Base Currency selection. When more than one currency is selected, they 
will appear below the toolbar as tabs. The terminal will remember 
your selection for convenience when the window is saved in a 
workspace.

Date Select FRAs based on International Money Market Dates, and free 
Forward Rate Agreements.

Contributor Select the sources of the information to be displayed. It can be 
global and regional banks, or inter-dealer broker data.

Columns Allows to customize the data to be displayed, such as mid yield 
and symbol name.

Consolidation When this option is selected, it displays a single set of quotes that 
correspond to the last updates.

Excel RTD Linking Select the series or instrument to export to Excel and press 
<CTRL>+<R>.

Forward Curves Double-click on any series to chart them. To compare them, click 
on any instrument while holding <CTRL> to drag and drop into an 
existing chart. Other instruments are supported.
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9.2.2 Useful keyboard shortcuts
Keyboard shortcut Description

<F11> Hides toolbar.

<CTRL>+<C> Consolidates the contributed data on a time of update basis.

<CTRL>+<RIGHT> Expands all collapsed groups.

<CTRL>+<LEFT> Collapses all groups.

9.3 Overnight Index Swaps

9.3.1 How to open
Search for "Overnight Index Swaps" in the search field and click the first result in purple > select a 
given currency from the list.
Main menu > "Explore" > "Money Market" > "OI Swaps" > select a currency from the list.
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Function Description

Base Currency selection. If more than one currency is selected, then 
these currencies will appear below the toolbar as tabs. Infront 
Professional Terminal will remember your selection for 
convenience when the window is saved in a workspace.

Contributor Select the sources of the information to be displayed. It can be 
global and regional banks, or inter-dealer broker data.

Columns Allows the tailoring of the data to be displayed, such as mid yield 
and symbol name.

Consolidation If selected, it displays a single set of quotes that correspond to the 
last updates.

Transpose Displays the data in a transposed matrix form.

Excel RTD Linking Select the series or instrument to export to Excel and press 
<CTRL>+<R>.

Forward Curves Double-click any series to chart them. To compare them, click on 
any instrument while holding <CTRL> to drag and drop into an 
existing chart. Other instruments are supported.

9.4 Bond Matrix

9.4.1 How to open
Search for "mortgage bonds" in the search field and click on the first result in purple > select a 
country from the list.
Main menu > "Explore" > "Fixed income" > "Mortgage bonds" > select a country from the list.
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Element Description

Issuer Select issuers.

x-axis, for example 1579 17-06 Displays issued series of the selected contributor.

y-axis, for example NRD Displays the quoted bid (bid yield) and ask (ask yield) of each 
contributor.

Yield Chart Opens the yield curve of the current series. Press <CTRL> and 
drag and drop to add any other series to the existing yield 
curve. Alternatively, double-click anywhere in the matrix.

Mid Displays the median of the mid-quotes of the listed 
contributors on the intraday time interval.

9.5 Interpolation Tool

9.5.1 How to open
For example, click a mortgage bond > this opens a curve chart > click "Interpolation".
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Function Description

Interpolation The default interpolation method is cubic splines, with 
constraints to ensure monotonicity, and overshooting 
minimisation. The output is the annualized rate for the selected 
date.

Curve Select the curve to interpolate.

Maturity Select the desired broken dates.

Discount factors Displays the discount factors for the selected dates.

Cash flow input Add the scheduled cash flows to calculate the present or future 
value.

Present and Future Value The sum of the inserted cash flows is displayed at the bottom 
of the window. Calculations are performed in continuous time 
(that is, not discrete).
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10 Corporate Debt module
Find out more about the Infront Professional Terminal Corporate Debt module.

Corporate Debt module has a special focus on pricing and fundamental data for listed and OTC debt in the 
Nordic and biggest European debt markets. The module is targeting buy and sell-side market participants 
looking for an effective, venue/contributor overview, possibility to calculate yield or price a bond on a given 
yield as well as calculate several important risk indicators. A powerful debt screening functionality allows 
the user to search by several important factors such as type, security, issuer industry and yield in addition 
to a free-text search which ensures the user will find what they are looking for every time.

Unique "Bond Overview" pages consolidate data for the instrument and display it in a way that provides the 
user with critical information in a timely and effective way. Bond overview covers reference data, market 
and indicative prices and an overview of the other issues from the same issuer. From here, the user can 
navigate further to each and every venue the bond is traded on, issuer fundamentals or proceed with 
analytics. Yield calculator calculates yield from price and price from yield until Maturity, Next call, Worst as 
well as a Custom date. The calculated yield is compared to a benchmark for spread analysis. Last but not 
least, the user can calculate the payment amount for a transaction taking into account principal and 
accrued interest.

10.1 Yield/price calculator - methodology
An analytic tool allowing to calculate a yield on a bond from a given price or a price from a given yield. The 
calculator provides flexibility to modify several calculation input factors for sensitivity analysis.

Calculator is filled with the reference and market data needed to perform a calculation. The latest available 
price (either market or indicative) is used by default.

Infront yield/price calculator currently supports calculations on the following types of bonds:

Fixed rate callable bonds
Floating rate bullet bonds
Floating rate callable bonds
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Zero coupon bonds
Perpetual fixed bonds

User can change the following values manually by either typing a new value or choosing a value from a 
drop-down list:

Element Description

Trade date Affect the settlement date.

Price source Depends on user’s access rights.

Price

Yield

To date The date to which calculation will be performed.

At price The redemption price of the bond.

Spread Spread between a chosen benchmark and current bond 
instrument.

Versus Benchmark to which the current bond will be compared.

10.2 Usability
Changing a price will trigger a yield and spread calculation.

Changing a yield will trigger a price calculation.

Modifying a spread will adjust the yield and trigger a price calculation.

Calculator performs calculations to the following "exit" dates:

10.3 Maturity – chosen by default
Element Description

Next call For instruments with one or more call option dates.

Worst Returns the worst yield and a date at which the yield is worst out of 
all possible exit dates.

Custom Calculation is performed for a date you specified.

Currently, spreads are calculated against a pre-defined list of government benchmark bonds. Default 
benchmarks are chosen based on maturity and country of a bond instrument. User can choose any 
benchmark bond from the drop-down list.

Calculated values are marked in bold and are blue. Modified values are marked bold and are green.

 Use refresh button to restore the original setup.



Infront Professional Terminal – Corporate Debt module

04/25/2022 238 / 258

10.4 Floating rate bonds
Infront yield/price calculator prices floating rate bonds using swap curves.

10.4.1 Methodology - Swap curves
Swap curves are bootstrapped using deposit rates for the short-term of the curve up to 1 year. For the long-
term of the curve, from 1 to 30 years, the curve is built using swap rates. These rates reflect the fixed 
coupon rate of a fixed-floating swap where the fixed leg would be valued at 100. Linear interpolation 
method is used to smooth out the curves. Where direct swap rates are unavailable due to illiquidity, basis 
swap rates are using to derive the needed swap rates.

Infront currently prices bonds using the following reference rates:

NIBOR: 1M, 3M, 6M

STIBOR: 3M

CIBOR: 6M

EURIBOR: 1M, 3M, 6M, 12M

10.4.2 Other methodology:
Price + Accrued interest =

Duration =

Where:

Frequency is the number of payments per year

P is the clean price plus accrued interest

N is the number of periods until maturity

Yield is yield to maturity

Li is the year fraction between the settlement date and the ith coupon

Modified duration =

Where:
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D is duration

Yield is yield to maturity

Convexity =

 

Where:

P is the current bond price

Y is yield to maturity

T is maturity in years

 

Current yield: annual interest payment / current price

Principal: Current price x Face Value

Accrued interest: CouponValue Date x Year fraction, where year fraction is calculated based on a day count 
convention for a bond

Payment amount: Principal + Accrued interest

10.5 Advanced
Advanced section of the calculator allows the user to modify several factors affecting the calculation. A 
new yield will be calculated immediately after a user changes an input. Each of the following input values 
can be changed by either typing in a new value or choosing a value from a drop-down menu:

Calendar country
Current coupon type
Coupon frequency
Day count convention
Current coupon size
Reference rate (for floating instruments only)
Spread (for floating instruments only)
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11 FX
Learn about the support for FX trading of spots and forwards.

See also:

FX trading
FX Forward Calculator

11.1 FX trading

11.1.1 FX trading
The program includes support for FX trading of spots and forwards if your provider supports it. You can 
place and execute deals on both asset classes and follow the deals of the day to get a full overview of FX 
deals.

The following windows are available for FX trading:

Window Description

"FX Spots" window Enables a grid view which can be customized to view 
selected spot currencies.

"FX Forwards" window Enables a grid view which can be customized to view 
selected forward currencies.

"Trading" window Provides overview of your deals and deal requests.

"New Deal" window Standard window for placing both spot and forward orders.

11.1.2 FX Spots window
The "FX Spots" window is the main window for displaying spot prices in the Infront Professional Terminal. It 
is a grid consisting of the spots of your selection which can easily be customized.

Each spot in the grid consists of:

Name of currency cross
Button to view a chart of the spot
High/Low
Sell and buy price
Tick indicator to display positive/negative change on price
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11.1.3 Currency setup
Before you can use the "FX Spots" window, you need to add the currency pairs you want to follow. The 
currency setup can be accessed by clicking the "+" sign in the spot grid or by clicking the "⋮" settings menu
icon in the top right corner followed by "Edit currency pairs".

There are two ways to add a new cross rate to the grid: By typing in the cross in the top left field or by click 
on the available currencies in the window. Typing in a cross and pressing <ENTER> or clicking "Add" will 
move that cross to the "Selected currencies list". Typing in an unavailable cross, the field will turn red and 
adding it in incorrect order will make the field yellow. When selecting a cross by using the mouse 
unavailable, crosses will go from bold to normal.

11.1.4 FX Forwards window
The "FX Forwards" window gives you a quick overview of selected currency pairs.
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11.2 FX Forward Calculator

11.2.1 FX Forward Calculator
Infront FX Forward Calculator allows you to calculate forward points and rates for a currency pair and any 
value (settlement) date, display forward curves as well as points charts. The calculator adjusts for non-
banking days and informs you about specific holidays and weekends. In addition, it allows you to set a 
pricing date in the past to extract the points and rates for the date chosen and display the adjusted forward 
curve. You can easily setup a broken date schedule with several date lines for a quick overview of the 
upcoming transaction prices.
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11.2.2 Single calculation panel
You can calculate forward points and rate for a single date by entering a currency pair and a value date. The 
value date is either a standard tenor (1M, 3M) or a broken date. If the chosen value date falls on a non-
business day, it will be rolled-over to the following business day automatically.

Spot date, day count convention and number of days can be checked by holding the mouse above the 
single calculation panel.

You can also calculate the transaction amount based on the real time rates of the chosen currency pair. 
This is done by entering a Buy or Sell amount which then triggers the calculation of the opposite. User can 
define an amount by typing in codes K for thousand and M for million. Typing in 25M will fill in the Buy/Sell 
section with an amount of 25,000,000.

11.2.3 Forward Curve and Chart
You can display a forward curve, points and rates, for the chosen currency pair by clicking "Forward Curve". 
The curve is adjusted once the user changes the currency pair. You can also display a forward curve chart 
by clicking the chart. The chart is built by using the forward points of the chosen currency pair. When 
changing a currency pair, the chart is not adjusted automatically.
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11.2.4 Broken dates schedule
FX Forwards Calculator calculates forward points and rates for any date by applying linear interpolation as 
follows:

Previous rate + ((Next Rate - Previous Rate)/DLP)*DPY

where

DLP = Number of days in the time interval between the two regular dates (first and second rate) 
DPY = Number of days from the earlier regular date to the interpolated date 
User can check which rates are used to interpolate each of the broken date rates by holding the mouse 
above the broken date line in question.

If any of the broken dates fall on a non-business day, it will be rolled-over to the following business day. 
These dates will be marked yellow. This feature can be disabled in the "Extended" menu of the FX Forwards 
Calculator. 
User can define broken dates by using several user-friendly codes:

Code Description

DD Sets day in the same month and year as Today.

DDMM Sets day and month in the same year as Today.

DDMMYY, DDMMYYYY Sets day, month and year.
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Code Description

+X, +Xd Adds X days to Today.

+Xm Adds X months to Today.

+Xy Adds X years to Today.

11.2.5 Extended menu
Extended menu allows for advanced functionality:

Price source changes
Pricing date changes
Day count changes

User can change both, spot and forward price sources.

User can change the pricing date to a past date. This will cause the calculations to be performed as-of-the 
chosen date. The rates used in calculations are the average rates for different tenors on the date defined as 
a pricing date. User is able to display a forward curve using those points and rates as well as perform 
broken date calculations.

User can disable the calculation on the adjusted dates. Calculations will then be performed on all dates 
disregarding holidays and other non-business days.
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12 Web trader
Discover, analyze and trade directly in your browser with the Infront Web Trader.

12.1 Before you start
Infront Web Trader is compatible with both Windows and Mac (OSX).

For the best experience, we recommend using Google Chrome or New Microsoft Edge.

Make sure that your bandwidth connection is sufficient.

12.2 Anti-Virus
Anti-virus software can interfere with the Web Trader data traffic. For more information, visit our FAQ page. 
To ensure the best performance, you should allow all traffic to the site domain.

To do this open your anti-virus program, go to advanced settings and URL Address Management.

Then add an exclusion URL to the Infront domain:

*.infrontservices.com

12.3 Cookies
Site cookies can interfere with Web Trader performance.

They can be cleared manually in the browser settings under "Privacy, Search and Services" (optionally 
enable the "clear browsing data on close" setting for "cookies and other site data").

Now you are ready to use Infront Web Trader
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13 Mobile app
Find out more about the mobile apps for iPhone, iPad and Android Infront provides.

Please visit Support and Downloads for the latest updates.

13.1 How to install the app
For more information, see the installation guide.
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13.2 Keep your watchlists and price alerts in the cloud
Do away with maintaining duplicate watchlists or price alerts. Create a list or price alert in Infront 
Professional Terminal or on any of your mobile devices and it will automatically be synced in the cloud.
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All of your alerts and watchlists are therefore saved to your specific user, making it easy to receive the 
alerts and access the same watchlists on any device.

13.2.1 Features
Orderbook with level 1 and level 2 data
Charts, orderbook and trades data
Customizable user interface on iPad
Equity analytics on global listed companies
Trading via your broker
News feed
Alerts

13.3 Available data
You will have access to the same services as through your Infront Professional Terminal subscription.
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14 FAQ and support
Access the Knowledge Base to get answers on frequently asked questions (FAQ) or just to create a new 
support ticket for the Infront Professional Terminal.

Clicking this link will open the Knowledge Base in a new tab: https://iptsupport.infrontfinance.com/en/
support/home
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15 Archive
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16 Infront Professional Terminal tutorials

16.1 Getting started tutorial
Learn how to use the Infront Professional Terminal with this getting started tutorial. Learn the basics and 
get a good overview how to use the market data and trading terminal.

16.2 Trading module tutorial
Watch part 1 of the trading tutorial where you will learn about the trading functionality and how to place a 
trade.

Watch part 2 of the trading tutorial where you will learn about trading functionality, how to display trades in 
a chart, and to create Matrices.

16.3 Curve chart tutorial
Discover the new "Curve Chart" function and how to navigate the menu icons, now included in the Infront 
Professional Terminal. Easy access toolbars and peer comparisons will make streamlining your work easier.

16.4 Charting tutorial
Learn how to use the Charting Tool within the Infront Professional Terminal.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=x3BmfQnwaZw?rel=0

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=KHSihwKLRVY

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=6_6engWO4Ys

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=S36yz6acsWU?rel=0
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16.5 

16.6 Watchlist tutorial
Learn how to create and use a watchlist and manage layouts in the Infront Professional Terminal.

16.7 Funds module tutorial
The Funds module allows you to access all the funds and ETF data you need, including all the data that you 
need to make an analysis or comparison.

16.8 Equity Analytics module 
The "Equity Analytics" module is the smartest equity analysis and valuation platform for finance 
professionals, streamlining your process with easy access to key information and time saving tools and 
Infront Estimates Data.

 

Learn how to use the Infront Professional Terminal Equity Analytics module in detail.

16.9 Infront Analytics tutorial
Discover the smartest business valuation and equity research platform for finance professionals.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=nPJ4BGitK-k?rel=0

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=n7Pa6UgleKI

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=L-d4KNJq2hg?rel=0

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=QTyy4gA3RIs?rel=0

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=Z330XyO8Iy0
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16.10 New RSP/RFQ function tutorial
Discover at a glance how the new RSP/RFQ feature within the Infront Professional Terminal allows for easy 
to use and fast trading tailored for the UK market.

16.11 Portfolio Tracker tutorial
Learn how to use the Infront Professional Terminal Portfolio Tracker function to help streamline your 
workspace, and visualize your holdings.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=KXFpTaNSlWM?rel=0

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=gwX5-Swf7RU?rel=0

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=Aem5OTXoqkA?rel=0
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17 Excel Add-in tutorials
You can find more video tutorials on this topic in the help of Excel Add-in.

17.1 Introduction to Excel Add-in
The Excel Add-in allows you to export real-time data from Infront Professional Terminal to create up to the 
minute reports.

17.2 Retrieve and compare company analytics part I
Learn how to retrieve and compare company analytics by using the Infront INFGET() function in Infront 
Professional Terminal.

17.3 Retrieve and compare Company Analytics part II
Learn how to use the INFGET () function panel to help you create customised reporting models to meet your 
specific business needs.

17.4 Advanced parameters in Excel
Understand how to use the Infront Professional Terminal Excel INFGET function's "Advanced Parameters".

17.5 Period and reference dates
Understand how to use the Infront Professional Terminal Excel INFGET function and use the "Period" and 
"Reference Dates" parameters in the Advanced Parameters.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=AoaMkXbZRMA

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=BbEIERqheBI

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=AoaMkXbZRMA

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=ipYAPjFMjeg
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Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=9n187B79LRI
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18 Downloads
Generate the current user manuals by clicking the corresponding buttons.

The comprehensive user manual can be downloaded directly.

User manual

Version: 8.6.500

Exported on: August 26, 2021

Size: 9.2 MB

Keyboard shortcuts in Infront 
Professional Terminal



Infront Financial Technology GmbH 

Mainzer Landstraße 178 – 190 

60327 Frankfurt am Main 

Customer Service: +49 69 26095760 

E-mail: supportde@infrontfinance.com 

www.infrontfinance.com
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